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DE PUERTO AYACUCHO- ESTADO AMAZONAS MEDIANTE TECNICAS 
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Resumen: En el siguiente trabajo se realizó la revisión e interpretación geológica de 

una zona ubicada al noroeste del estado Amazonas, a través del procesamiento de las 

imágenes satelitales Landsat 7 ETM+, la revisión de los mapas geológicos y 

topográficos y la bibliografía de los trabajos previos. 

 El uso de los sensores remotos se aplica a esta área en particular debido a lo 

económico del proceso y porque es un medio viable para estudiar zonas de difícil 

acceso en cuanto a lo intrincado de la vegetación, costosa logística en cuanto a la 

lejanía de centros poblados y además de mitigar el riesgo que acarrea ir a campo en 

zonas fronterizas más aún en estados cercanos a la República de Colombia.  

Una vez recopilada y revisada toda la información bibliográfica se procedió a 

correlacionar estos datos con los resultados obtenidos mediante el procesamiento de 

las imágenes satelitales y comparar los contactos litológicos, lineamientos 

estructurales y la morfología del relieve observado para generar la cartografía 

geológica. 

La zona de estudio se encuentra en la margen oeste del macizo de Guayana y 

la litología predominante pertenece al batolito del Granito de Parguaza y a 

sedimentos coluvio-aluviales en las áreas de menor relieve.  
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El resultado que se obtuvo fue la elaboración de un mapa geológico a escala 

1:100.000 del área, el cual presenta un mayor nivel de detalle, con respecto a los 

mapas de referencia, los contactos litológicos, las estructuras, morfología del relieve 

y características de suelo y vegetación, ya que los mapas de referencia están a una 

menor escala que el producto de esta investigación. 
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CAPÍTULO I 

INTRODUCCIÓN 

OBJETIVOS Y ALCANCES DEL TRABAJO 

 
 Pocos son los estudios geológicos realizados en diferentes zonas del país que 

emplean las imágenes satelitales (multiespectrales) como herramienta, a pesar de su 

alta versatilidad, en la simplificación de los trabajos de interpretación de 

características geológicas de manera remota. Es por esta razón que se emplearán y 

aprovecharán las imágenes satelitales como una importante fuente de información 

que aporten datos característicos de rasgos geológicos. A continuación se presenta el 

objetivo general y específico que contempla el estudio. 

 

1.1 OBJETIVO GENERAL: 

 
El objetivo general de este trabajo es generar un mapa geológico a escala 

1:100.000 del área comprendida, a través la integración geológica de las revisiones 

bibliográficas y trabajos previos consultados con los resultados obtenidos en el 

procesamiento de la imagen satelital (Landsat 7 ETM+), donde se muestre la 

correspondencia entre la geología superficial descrita en estudios previos y la 

interpretación de las imágenes multiespectrales. 

 

1.1.2 OBJETIVOS ESPECÍFICOS: 

 
Para cumplir con lo antes expuesto se establecen los siguientes objetivos: 

 

- Determinar las estructuras geológicas presentes en el área de estudio a través 

de la interpretación visual de las imágenes satelitales Landsat 7 ETM+ P003R056 y 

P004R056. 
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- Realizar el análisis geomorfológico de la zona de estudio mediante el uso de 

las imágenes satelitales, mapas topográficos y  geológicos. La finalidad de esto es 

reconocer la distribución de cada una de las unidades dentro del área de estudio, el 

patrón de drenaje, estructuras, tipos de suelo y vegetación asociado a cada unidad 

litológica y la relación entre ellas.  

 

- Realizar la clasificación supervisada y no supervisada para realzar las 

características geológicas de la zona. 

 

- Realizar el Modelo Digital de Elevación del área utilizando el software 

ENVI ® 4.2, para la observación tridimensional (3D) del relieve presente en la zona 

de estudio. 

 

- Generar un mapa geológico a escala 1:100.000 de la zona de estudio, 

utilizando el “software” ArcGIS 9.1, donde se muestre las características 

geomorfológicas, topográficas, hidrológicas. 

 

 

1.2 LOCALIZACIÓN Y EXTENSIÓN DEL ÁREA DE ESTUDIO 

 La zona de estudio está ubicada en el Escudo de Guayana, específicamente en 

la región sur-occidental de Venezuela, entre los estados Amazonas (municipio 

Atures) y Bolívar (municipio Cedeño), limitada por las coordenadas 67°00’ a 67°30’ 

(longitud oeste) y 5°40’ a 6°00’ (latitud norte), correspondiente a la hoja topográfica 

6733 (Serranía el Espejo), con una extensión areal de 2016 km² aproximadamente 

(FIG. 1-1). 
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FIG. 1- 1 Ubicación  del área de estudio, seleccionado con el  rectángulo rojo. Tomado y modificado de 

www.ingeolan2009.com 

 

1.3  METODOLOGÍA 

 

La ejecución del presente trabajo se realizó por etapas, las cuales serán 

descritas a continuación: 

 

1.3.1 RECOPILACIÓN BIBLIOGRÁFICA Y CARTOGRÁFICA: 

 
Consiste en la búsqueda, recolección y estudio de la documentación 

cartográfica y geológica existente, para tener un mejor conocimiento de la zona de 

estudio, tal como:  
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- Trabajos Especiales de Grado de la Escuela de Geología, Minas y Geofísica 

(UCV), con el objetivo de conocer las características estructurales y litológicas 

regionales de la zona. 

- Publicaciones de Revistas y en Congresos Geológicos Nacionales e 

Internacionales. 

- Informes y mapas geológicos de los Ministerios de Energía y Minas (MEM),  

Ministerio  del Ambientes y sus Recursos Renovables Naturales e  INGEOMIN. 

-  Proyecto del plan de ordenamiento territorial del estado Amazonas (2003), 

obtenido en el MARNR. 

- Mapa de Geología Hojas NB 19-11/ NB-19-12 de CVG Técnica Minera, a 

escala 1:250.000 (1996). 

- Mapa geológico de la parte norte del Territorio Federal Amazonas, a escala 

1:500.000 por Mendoza y otros, (1977). 

-  Hoja topográfica 6733 (Serranía El Espejo, año 1973) a escala 1:100.000 y 

ortofotomapas de la hoja 6733 (cuadrantes I, II,III,IV) a escala 1:50.000 del Instituto 

Geográfico de Venezuela Simón Bolívar (I.G.V.S.B), que servirán como mapas base 

de la zona de trabajo. 

 

1.3.2 TRABAJO DE LABORATORIO: 

 
 El trabajo de laboratorio comprendió la digitalización, vectorización de las 

imágenes satelitales, mapas topográficos, mapas geológicos y ortofotomapas de la 

zona de estudio, con el fin de llevar a formato digital la información recopilada  a 

través del manejo del programa ArcGis 9.1, para la elaboración de un mapa geológico 

del área a escala 1:100.000.  

 

Esta etapa incluye el procesamiento, calibración y posterior interpretación de 

las imágenes satelitales, de la siguiente manera: 
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 1.3.2.1 Calibración y preprocesamiento de las imágenes satelitales:  

 

Antes de ser usadas, las imágenes satelitales requieren correcciones 

radiométricas, las cuales remueven los efectos de los errores del sensor y los factores 

ambientales (atmosféricos) y así obtener un mejor resultado. Estas correcciones se 

realizan mediante el empleo y manejo de los programas de computación: ENVIS 4.1, 

ERDAS IMAGINE 8.6 y ARCGIS 9.1. La metodología aplicada para el 

procesamiento de las imágenes satelitales esta explicado paso a paso en el Apéndice 

anexado a este trabajo. 

 

1.3.2.2 Interpretación de las Imágenes satelitales: 

 

Una vez realizada la calibración y procesamiento de las imágenes satelitales 

P003R056 y P004R056, se procede a la interpretación de las mismas mediante el 

manejo de los “softwares” antes mencionados, con la finalidad de identificar drenajes, 

estructuras, posibles contactos litológicos, geometría y todos aquellos rasgos 

topográficos que sean de interés para el intérprete.  

 

1.3.2.3 Elaboración del Mapa Geológico. 

 

Luego de la interpretación de las imágenes satelitales antes mencionadas  en 

conjunto con los trabajos previos consultados se genera el mapa geológico de la zona 

de estudio correspondiente a la Serranía el Espejo a escala 1:100.000 (Anexo N°1), 

con el fin de cumplir con el objetivo general planteado en el presente trabajo 

especial de grado. 
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CAPÍTULO II 

2. MARCO TEÓRICO 

 
Este trabajo, analiza la naturaleza de la obtención de datos a través de 

imágenes satelitales, y el mejoramiento de la calidad de los mismos teniendo en 

cuenta diferentes factores inherentes a los procesos de dispersión selectiva de la 

radiación electromagnética por efectos atmosféricos.  

 

2.1 CONCEPTOS PRELIMINARES 

 
Para una mejor comprensión del contenido de este análisis, resulta necesario 

abordar antes algunos conceptos y fundamentos físicos, los cuales se presentan a 

continuación. 

 

2.1.1 TELEDETECCIÓN 

 
La teledetección o percepción remota es una técnica que ha ido evolucionando 

aceleradamente durante las últimas década con el advenimiento de la tecnología 

satelital, sus orígenes se ubican con el inicio de las actividades aeronáuticas a 

principio de siglo XX para ir evolucionando con el desarrollo de las actividades 

espaciales. Hoy en día, las definiciones de teledetección se utilizan para describir las 

actividades que realizan los satélites, trasbordadores espaciales o determinado tipo de 

aviones. 

Las siguientes definiciones establecen algunos parámetros de lo que la 

comunidad científica considera a la palabra teledetección o percepción remota: 

 

La percepción remota es la colección de información de un objeto sin estar en 

contacto físico con él. Aeroplanos, aviones y satélites son las plataformas más 

comunes desde donde las observaciones remotas son realizadas.  
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El término percepción remota es restrictivo a métodos que emplean energía 

electromagnética como medio de detección y medición de las características de un 

objeto (Sabins, 1978). 

 

Es aquella técnica que permite adquirir imágenes de la superficie terrestre 

desde sensores instalados en plataformas espaciales. Gracias a la interacción de la 

energía electromagnética que existe entre el sensor y la tierra (Chuvieco, 1990) 

 

Medida o adquisición de información relacionada con una propiedad de un 

objeto, mediante un dispositivo de grabación que no se encuentra en contacto físico 

con el objeto en estudio. (ASPRS, 1996) 

 

Arte, ciencia y tecnología de adquirir información confiable sobre un objeto 

físico, mediante procesos de grabación, medición, interpretación y registro de los 

patrones digitales de energía derivados de sistemas sensores que no contactan al 

objeto. (Colwell, 1997) 

 

 

 

 

 

 

 

 

 

 

 

 

 



GONZÁLEZ Y MILLÁN                                                                                               MARCO TEÓRICO 

 

8 
 

2.1.2 ELEMENTOS DE UN PROCESO DE TELEDETECCIÓN 

 

De forma gráfica, los elementos básicos de un sistema de teledetección son (FIG. 2-
1):  
 

 
FIG. 2- 1 Proceso de la  percepción remota. Fuente: Goyo. IGVSB, 2008 

 

Donde: 

Fuente de energía: Es la que da origen al flujo energético que es detectado 

por el sensor.  

 

La radiación y la atmósfera terrestre: Para que la energía vaya de la fuente 

hacía el objeto, necesita atravesar e interactuar con la atmosfera. Esta interacción 

también sucederá cuando la energía retorne de vuelta desde el objeto al sensor. 

 

Interacción con la superficie terrestre: Cuando la energía llega a la tierra 

interactúa con el objeto de interés conformado por las diversas coberturas de la tierra 

(superficie terrestre, atmósfera, océano), esta interacción se da en forma de algún 

fenómeno (reflexión, emisión, absorción). 
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Sistema del sensor: Es el que capta, codifica y graba la radiación que 

devuelve el objeto en tierra, sin estar en contacto con él. Después envía al sistema de 

recepción en tierra la energía grabada. 

 

Transmisión, recepción y procesamiento: Aquí los datos, recibidos en 

forma digital, son procesados para obtener una imagen, bien sea en papel o en medio 

digital. 

 

Interpretación y análisis de los datos: La imagen procesada es interpretada 

en forma visual o se le aplica adicionalmente procesamiento a través de técnicas 

digitales.    

 

Apoyo para el desarrollo de aplicaciones: Es el elemento final del proceso 

de la Percepción Remota. Consiste en realizar aplicaciones con la información 

temática que se extrae de la imagen, entendiendo el comportamiento de los objetos de 

interés, para la solución de algún problema en particular. (Alzate, 2001) 

 

2.1.3 BASES FÍSICAS DE LA TELEDETECCIÓN 

 

Existen dos componentes básicos del sistema de los sensores remotos: 1) La 

fuente de  energía y 2) La ruta de transmisión objetivo y sensor. Ellos trabajan juntos 

para medir y registrar la información acerca del objetivo sin entrar en contacto físico 

con él. Para que esto suceda “algo” debe actuar como medio para transmitir la 

información desde el objetivo hasta el sensor.  

 

Para la teledetección terrestre, en la mayoría de los casos, ese “algo” es la 

energía electromagnética. (Alzate, 2001). 
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2.1.3.1 Energía Electromagnética. 

Es la cantidad de energía almacenada en una región del espacio que se puede 

atribuir a la presencia de un campo electromagnético, y que se expresará en función 

de las intensidades de campo magnético y campo eléctrico (Chuvieco, 1990).  

 

 La propiedades de esta radiación, ha sido explicada a través de dos teorías 

(Chuvieco, op. cit.): 1)  La teoría Cuántica y 2) La Teoría Ondulatoria, en las cuales, 

la primera concibe a la radiación como una sucesión de unidades discretas de 

energía,fotones o cuantos, con masa igual a cero; mientras que la segunda, establece 

que la energía se propaga siguiendo un modelo armónico y continuo, a la velocidad 

de la luz y contenido entre dos campos de fuerzas ortogonales entre si: eléctrico y 

magnético. 

 

  Según la teoría ondulatoria, la radiación electromagnética está constituida por 

cuatro parámetros que definen sus propiedades (FIG. 2-2) 

 

 
FIG. 2- 2 Parámetros que constituyen una onda (Tomado y modificado de Chuvieco, 1990) 

 

Donde: 

Amplitud (A): Es la altura de la onda y se define como la máxima distancia 

que alcanza un punto al paso de las ondas respecto a su posición de equilibrio 

(Salazar, 2004). 
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 Frecuencia (ν): Es la medida del número de ondas que pasa por un punto en 

la unidad de tiempo. Generalmente se mide en hertzios (Hz), siendo un hertzio 

equivalente a una vibración por segundo. Por ello, también se utiliza el s-1 como 

unidad para medir la frecuencia. También, se puede definir como la inversa de su 

período T, que es el tiempo que tarda en avanzar una distancia igual a su longitud de 

onda (Salazar, op. cit.). 

 

Longitud de onda (λ): Es la distancia entre dos crestas consecutivas, que 

debido a la gran variedad de longitudes de onda que existen, suelen usarse múltiplos 

como el kilómetro (para ondas largas como las de radio y televisión) o submúltiplos 

como el nanómetro o el Angstrom (para ondas cortas como la radiación visible o los 

rayos X) (Salazar, op. cit.). 

 

Velocidad (v): Es la rapidez con que se propaga la onda (Salazar, op. cit.), se 

calcula utilizando la siguiente ecuación: 

 

                                                C = λ * ν 
Donde: 

C = Velocidad de la onda 

λ = Longitud de la onda 

ν = Frecuencia 

 

La teoría Cuántica y la Ondulatoria de la radiación se concilian en la relación de 

Planck: 

                     ε = h ν 

Donde, 

ε = energía del fotón 

h=constante de planck (6.63*10-34js)  

ν=  frecuencia del movimiento ondulatorio. 
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La relación de Planck permite que un haz de luz de radiación de determinada 

frecuencia(o longitud de onda) sea interpretado como un flujo de determinada 

energía. 

 

 La energía electromagnética existe en muchas formas además de luz visible 

como: Ondas de radio, Microondas, Calor, Rayos ultravioletas, Rayos x, Rayos 

gamma. Cada uno de ellos describe la energía en una región específica del espectro 

electromagnético. 

2.1.3.2 Espectro Electromagnético 

 
El espectro electromagnético es una representación organizada de la energía 

electromagnética, partiendo de longitudes de onda corta (rayos cósmicos y rayos 

gamma) a longitudes de onda largas (radio y televisión) Fig 2-3. (Alzate, 2005).  

 

 

 
FIG. 2- 3 Longitudes de onda del espectro electromagnético. Fuente: Goyo. IVSB, 2008 

 

En la teledetección conviene destacar una serie de bandas espectrales 

utilizadas con frecuencia (FIG. 2-4) las cuales son descritas a continuación:  
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FIG. 2- 4 Bandas del espectro electromagnético y sus longitudes de onda, frecuencia y energía. Fuente: 

http://es.wikipedia.org/wiki/Espectro_electromagn%C3%a9tico 
 

Espectro visible (0.4 - 0.7 µm): se denomina así por tratarse de la única 

radiación electromagnética que puede recibir el ojo humano, coincidiendo con las 

longitudes de onda donde es máxima la radiación solar.  

 

Suelen distinguirse tres bandas elementales: azul (0.4 a 0.5 µm), verde (0.5 a 

0.6 µm) y rojo (0.6 a 0.7 µm), estos son los colores primarios que el ojo humano 

percibe a esas longitudes de onda (FIG. 2-5). 

 

 
FIG. 2- 5 Colores del espectro visible. Fuente: 

http://es.wikipedia.org/wiki/Espectro_electromagn%C3%a9tico 
 

Infrarrojo próximo (0.7 – 1.3 µm): también llamado infrarrojo reflejado o 

fotográfico, puesto que parte de él puede detectarse a partir de películas dotadas de 
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filtros especiales. Es de gran importancia por su capacidad de discriminar masas 

vegetales y concentraciones de humedad. 

 

Infrarrojo medio (1.3 – 8 µm): es donde se mezclan los procesos de reflexión 

de la luz solar y de emisión de la superficie terrestre. 

 

Infrarrojo lejano o térmico (8 - 14 µm): incluye la poción emisiva del espectro 

terrestre. 

 

Microondas ( a partir de 1 mm): de gran interés por ser un tipo de energía 

bastante transparente a la cubierta nubosa. 

 

2.1.3.3 Interacción de la radiación electromagnética con los elementos de la 

superficie terrestre. 

 
La radiación electromagnética al interactuar con los objetos es modificada de 

manera que la energía resultante incorpora información que caracteriza al objeto y en 

consecuencia indirectamente permite su análisis. La forma de interacción de la 

radiación electromagnética con la superficie terrestre se resume en la figura 2-6 

(Méndez, 2002) 

 

De acuerdo a su longitud de onda, una parte de la radiación incidente en el 

objeto es dispersada en diferentes direcciones, otra es absorbida por la materia, otra es 

transmitida y otra reflejada. 
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FIG. 2- 6 Interacción de la radiación electromagnética con la superficie terrestre. Fuente: Méndez 

(2002) 
 

La cantidad total de radiación que golpea un objeto es llamada radiación 

incidente y es igual a: 

 

Radiación incidente= radiación reflejada+ radiación absorbida+ radiación 

transmitida 

 

La absorción ocurre cuando la radiación (energía) es absorbida dentro del 

objeto. La reflexión ocurre cuando la radiación “rebota” del objetivo y es 

redireccionado en otra dirección. La transmisión, ocurre cuando la radiación pasa a 

través del objetivo, ver figura 2-7. En sensores remotos se esta más interesado en 

medir la radiación reflejada desde los objetivos (CCRS, 2007) 
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FIG. 2- 7 La energía incidente, A: absorción, R: reflexión, T: transmisión. Tomado del CCRS (2007) 

 

2.1.4 TIPOS DE REFLECTANCIA 

 
Existen dos tipos de reflectancia, dependiendo de las irregularidades de la 

superficie y la longitud de onda incidente (FIG. 2-8). 

 

 1) Especular ó espejo: es la reflexión de las superficies lisas en relación con 

la longitud de onda. Las partículas de la superficie son pequeñas en relación con la 

longitud de onda incidente. La luz es desviada en una sola dirección. El ángulo de 

reflexión es igual al ángulo de incidencia. 

 

2) Lambertiana ó Difusa: ocurre cuando la superficie es rugosa y la energía es 

reflejada en todas las direcciones. Un reflector difuso perfecto es referido a una 

superficie lambertiana y su brillo reflectivo es el mismo cuando se observa desde 

cualquier ángulo (Alzate, 2005). 

 

 
FIG. 2- 8 Reflexión especular y reflexión lambertiana, Tomado de CCRS (2007) 
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2.1.5 INTERACCIÓN DE LA ENERGÍA ELECTROMAGNÉTICA  CON LA 

ATMOSFERA 

 
La modificación atmosférica de la radiación electromagnética entrante y 

saliente incluye dispersión, refracción y absorción (FIG. 2-9). Esos tres procesos 

modifican físicamente la dirección y penetración de la radiación electromagnética, en 

el momento en que pasa a través de la atmósfera (Alzate, 2001). 

 

 

 
FIG. 2- 9 Interacción de la energía con la atmósfera y la superficie. Fuente: CCRS (2007) 

 

2.1.5.1.- Dispersión (Difusión) 

Es el redireccionamiento de la energía electromagnética por partículas 

suspendidas en la atmósfera (contaminación, polvo) o por moléculas grandes de gases 

atmosféricos (dióxido de carbono, ozono, gas, nitrógeno). Este redireccionamiento de 

la luz puede ser en cualquier dirección (Alzate, 2001). 
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2.1.5.2.- Refracción 

Es la desviación de la luz. Sucede cuando la luz pasa a través de dos medios 

con diferente densidad (capas atmosféricas) (Alzate, 2001). 

 

2.1.5.3.- Absorción 

La absorción atmosférica tiene una particular importancia en percepción 

remota especialmente en lo relacionado a sensores pasivos, que utilizan la radiación 

electromagnética proveniente del sol, ya que la atmósfera se comporta como un filtro 

selectivo de tal forma que algunas regiones del espectro eliminan cualquier 

posibilidad de observación remota (Chuvieco, 1990). 

 

Es principalmente causada por tres gases atmosféricos (FIG. 2-10): ozono, 

absorbe los rayos ultravioleta; dióxido de carbono, en la atmósfera inferior absorbe 

energía cuya longitud de onda esta entre los 13 – 17,5 micrómetros; vapor de agua, 

también en la atmósfera inferior, principalmente en áreas húmedas es efectivo 

absorbiendo las porciones del espectro entre 5,5 y 7 micrómetros y por encima de los 

27 micrómetros como se muestra en la (FIG. 2-10). 
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FIG. 2- 10 Susceptibilidad a la absorción atmosférica. Tomado de Goyo (IGVSB, 2008). 

 

 
FIG. 2- 11 Absorción Atmosférica. Fuente: Goyo. IGVSB, 2008. 

 

2.1.5.4.- Ventana Atmosférica 

 
 Son porciones del espectro electromagnético que pueden pasar a través de la 

atmósfera con poca o ninguna atenuación. La figura 2-12 muestra las áreas del 

espectro que pueden pasar a través de la atmósfera sin atenuación (picos), son 

conocidas como “ventanas atmosféricas”, y las áreas que son atenuadas (valles). 
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FIG. 2- 12 Ventanas atmosféricas. Fuente: Alzate (2001) 

 

Las zonas azules señalan el paso mínimo de radiación entrante o saliente, 

mientras que las áreas blancas denotan las “ventanas atmosféricas” en las cuales la 

radiación experimenta interacciones muy reducidas con las especies moleculares y 

desde aquí puede penetrar la luz, con poca o ninguna pérdida de absorción (Alzate, 

2001) 

 

La mayoría de los sensores remotos fueron seleccionados para operar en una o 

más de esas ventanas y hacen sus mediciones usando detectores calibrados para 

ciertas frecuencias especificas (longitudes de onda), que pasan a través de la 

atmósfera (Alzate, 2001)  

 

2.1.6 SENSORES REMOTOS 

  
 Son los dispositivos que permiten la referenciación a distancia de la radiación 

electromagnética reflejada o emitida por la superficie de la tierra. Estos son de 

diferentes tipos, de acuerdo con los principios básicos de diseño, su forma de registrar 

los datos y la fuente de energía que emplean. Pueden ser cámaras, radares, barredores 

ópticos, óptico-mecánicos, eléctricos, etc. (Alzate, 2001). 
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2.1.6.1 Tipos de Sensores 

 
 La clasificación de los sensores más usada en la teledetección son (FIG. 2-13): 

 
FIG. 2- 13 Tipos de sensores. Fuente: Goyo.  IGVSB, 2008. 

 

Según el aporte de energía se pueden distinguir dos tipos de sensores: 

 

Pasivos: Son aquellos que poseen fuente de energía natural, como la energía 

solar y el calor radiante. Es decir,  este tipo de sensores recogen la energía 

electromagnética procedente de la cubierta terrestre, ya sea reflejada  de los rayos 

solares o emitida debido a su propia temperatura (FIG. 2-14). 

 

 
FIG. 2- 14 Fuente de energía pasiva. Tomado del CCRS (2007) 
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Activos: Emiten su propio has de energía, el sensor emite radiación sobre el 

objeto que se desee observar y la radiación reflejada desde el objetivo es detectada y 

medida por el sensor (FIG. 2-15). Ejemplos: 

SLAR: Radar lateral aerotransportado, baja resolución. 

SAr: Radar de apertura sintética, se basa en el efecto Doppler. 

lidar: Pulsos de luz polarizada, región del espectro en UV y el IRC. 

 

 
FIG. 2- 15 Fuente de energía activa. Tomado de: CCRS (2007) 

 

 

2.1.7  ADQUISISIÓN DE INFORMACIÓN DE UN SENSOR REMOTO: 

 
Hay tres formas de adquirir información a partir de un sensor remoto (FIG. 2-

16). 

i) Por Reflexión: El sol ilumina a superficie terrestre y la energía reflejada, en 

función del tipo de cobertura es captada por el sensor. Entre la superficie y el sensor 

se interpone la atmósfera que dispersa y absorbe parte de la señal original. 

 

ii) Por Emisión: La percepción remota se basa en la energía emitida por la 

cobertura, siendo sus propiedades térmicas dominantes. 
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iii) Por emisión/Reflexión: Un sensor que genere su propio flujo energético 

(emisión) y a la vez pueda recoger su reflexión después de ésta haber interactuado 

con la superficie. 

 

 
FIG. 2- 16 Las 3 formas de teledetección (Adaptado de Chuvieco, 1995) 

 

2.1.8 RESOLUCIÓN DE LOS SENSORES 

 
 La resolución de un sistema sensor es la habilidad para registrar información a 

detalle, discriminándola. Estes y Simonett, 1975. 

 

2.1.8.1 Tipos de Resolución.  

Un sensor opera bajo los siguientes parámetros: 

 
Espacial: Es el objeto mas pequeño que puede ser distinguido sobre la 

imagen. Solo se pueden discriminar en la imagen, elementos de tamaño superior a la 

resolución espacial (es decir, al tamaño del píxel). La resolución espacial esta 

relacionada con la escala de trabajo (FIG. 2-17) y la fiabilidad de la información. 

(Chuvieco, 1996). 

 

(i)   REFLEXIÓN 
(ii)  EMISIÓN 
(iii) EMISIÓN/REFLEXIÓN 
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FIG. 2- 17 Resolución espacial relacionada con la escala de trabajo. Tomado de  Goyo.  IGVSB, 2008 
 

Espectral: Es el número y el ancho de las bandas espectrales que puede 

discriminar el sensor (FIG. 2-18).  

 

 
FIG. 2- 18 Resolución Espectral. Número y anchura de cada banda. Tomado de :Goyo. IGVSB, 2008 
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Los satélites pueden clasificarse como monoespectrales, para caso de los 

radares que presenta solo una banda, multiespectrales, de 2 a varias bandas (FIG. 2-

19), e hiperespectrales, capaces obtener información simultánea de cientos de bandas 

(Chuvieco, 1996). 

 
FIG. 2- 19 Resolución Espectral con más de 2 bandas. Tomado de Goyo. IGVSB, 2008. 

 
 Radiométrica: Es la sensibilidad del sensor, es decir, la capacidad para 

detectar variaciones en la radiancia espectral que recibe (FIG. 2-20). Determina el 

número de niveles de gris recogidos en el film, se expresa en niveles por píxel (64-

128-256-1024). A mayor resolución radiométrica, mejor interpretación de la imagen.  

El píxel mixto es definido por una señal intermedia a las cubiertas que lo componen 

(Chuvieco, 1996). 

 
 

 
FIG. 2- 20 Resolución Radimétrica a distintos niveles digitales: 2 y 8 bits. Tomado de Chuvieco, 1995. 
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Temporal: es la periodicidad con que el sensor adquiere imágenes de la 

misma porción de la superficie terrestre. Esta en función de las características 

orbitales de la plataforma (altura, velocidad e inclinación) y del diseño del sensor 

(ángulo de observación y ángulo de cobertura) (Chuvieco, 1996).  El ciclo de 

recubrimiento es el tiempo que tarda el sensor en pasar sobre la misma porción de la 

tierra, el periodo orbital es el tiempo que él tarda en circundar la tierra. 

 

Los satélites meteorológicos están obligados a facilitar una información muy 

frecuente, ya que se dedican a observar un fenómeno en gran dinamismo (FIG. 2-21). 

De allí que la red de satélites geoestacionarios proporcione una imagen cada 30 

minutos, que complementa la obtenida a partir de los satélites de órbita polar, como el 

NOAA que proporciona información cada 12 horas. 

 

 
FIG. 2- 21 Resolución Temporal de un satélite meteorológico. Tomado de  Goyo. IGVSB, 2008 

 

En el otro caso, los satélites meteorológicos ofrece una secuencia mucho 

menor, es de 16 días del Landsat (FIG. 2-22) a 26 días del Spot (Chuvieco, 1996). 
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FIG. 2- 22 Resolución Temporal del  Landsat para la adquisición de Imágenes. Tomado de Goyo. 

IGVSB, 2008 
 

2.1.8.2 Relación entre los tipos de resoluciones. 

 
Los cuatro casos de resolución están íntimamente relacionados, por ejemplo, 

cuando se tiene mayor resolución espacial disminuye la resolución temporal y es 

posible que se reduzca también la espectral y la radimétrica (ver Fig 2.23). Un 

problema adicional es que al aumentar cualquiera de las cuatro resoluciones, se van a 

generar un volumen mayor de datos que las estaciones de trabajo tienen que procesar 

(Salazar, op. cit.). 

 

Es necesario aclarar primero cual será la aplicación de las imágenes; para 

definir cual resolución es la que más conviene aumentar; a continuación se muestra 

una tabla que refleja el tipo de resolución que se debe aplicar dependiendo de la 

actividad a realizar. 
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FIG. 2- 23 Ejemplos  de resoluciones aplicadas a actividades  específicas. Tomado de Chuvieco,1996. 
 
 

2.1.9 FIRMAS ESPECTRALES 

 
          Cada objeto en la superficie terrestre interactúa de manera específica con la 

energía electromagnética que sobre el incide. De acuerdo a las características del 

material que lo componen, el objeto refleja con mayor o menor intensidad cada uno 

de los rangos de longitudes de onda, esta interacción particular de la materia 

constituye su firma espectral.  

2.1.9.1 Factores de incidencia en la respuesta espectral de las cubiertas 

 
 La respuesta de los cuerpos de la energía incidente no siempre será la misma, 

dependerá de varios factores tales como (FIG. 2-24):  

 

(i) Altura Solar: Angulo de incidencia de la energía con el cuerpo (varia 

según fecha del año y recorrido del satélite). 

 

(ii) Orientación: Laderas, zonas de umbría y lozana. 

 

(iii) Pendiente: Ángulo de observación. 
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(IV)Interacción atmosférica: con las distintas longitudes de onda 

 

(V) Variaciones ambientales: Asociación con otras cubiertas, grado de 

homogeneidad. 

 

(IV) Aspecto del relieve: presencia de diferentes superficies. 

 

 
FIG. 2- 24 Factores que influyen en la incidencia de la respuesta espectral. Tomado de Chuvieco, 

1996. 
 
 

2.1.9.2 Reflectividad 

 
La reflectividad de los cuerpos varían según la longitud de onda que incide 

sobre ellos, normalmente la reflectividad de los cuerpos aumenta a medida que la 

longitud de onda disminuye, no obstante existen cuerpos donde esta relación es 

inversa (nieve) o irregular (vegetación). También la reflectividad esta influenciada 

por la textura del cuerpo, para una misma longitud de onda, la reflectividad baja se 

encuentra en el agua, aumenta para el suelo, vegetación enferma, vegetación sana y es 

máxima para la nieve (FIG. 2-25) (Chuvieco, 1996).  
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FIG. 2- 25 Firma espectral de distintos tipos de cubiertas. Tomado de Goyo. IGVSB, 2008 

 

2.1.9.3 Respuesta de la vegetación  

 
En el análisis de la superficie de la vegetación a través de imágenes de satélite 

se deben tener en cuenta aspectos como la morfología de la cubierta (estado 

fenológico, proporción de sombras, geometría del follaje y contenido de humedad), y 

la ubicación en el relieve y su asociación con otras cubiertas o especies. 

 
Por ejemplo, la hoja de los árboles la percibimos de color verde porque refleja 

con mayor intensidad las longitudes de onda visibles de ese color, esto debido al 

efecto absorbente de los pigmentos fotosintéticos de las hojas, mientras que absorbe 

el azul y el rojo por el contenido de clorofila en las hojas, ver Fig. 2-26 y 2-27 

(Méndez, 2002).  

La estructura celular interna da la elevada reflectividad en el infrarrojo 

cercano que luego va reduciéndose paulatinamente hacia el infrarrojo medio.  
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Por tanto, el contraste más nítido se presenta entre las bandas visibles 

(especialmente rojo) y el infrarrojo cercano. Cuanto mayor sea ese contraste, mayor 

será el vigor de la vegetación.  

 
FIG. 2- 26 Respuesta espectral de la vegetación. Tomado de  Méndez (2002) 

 

Estos tres parámetros: cantidad de pigmentos, estructura celular y contenido 

en agua, manifestados por la respuesta espectral de esa masa de vegetación de la que 

forman parte, puede servir para discernir entre unas especies y otras, su nivel de 

desarrollo e incluso entre su estado sanitario ver Fig. 2-26 y 2-27 (Lanero, s/f) 
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FIG. 2- 27 Respuesta espectral de la vegetación Sana. Tomado de  Goyo. IGVSB, 2008 

 

2.1.9.4 Respuesta del suelo 

 
La respuesta del suelo a la reflectividad de las longitudes de onda está 

influenciada por características como: la composición química, textura, estructura y 

contenido de humedad. El contenido de materia orgánica en el suelo reduce la 

reflectividad. 

2.1.9.5 Respuesta del agua 

 
La respuesta del agua varía según la longitud de onda, dentro del espectro 

óptico infrarrojo.  

 

El agua tiende a absorber la energía a medida que la longitud de onda 

aumenta, en el caso de las microondas, estás son reflejadas especularmente si el agua 

esta tranquila; si hay turbulencia u oleajes, la energía es reflejada en varias 

direcciones.  
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La respuesta del agua también esta influenciada por la profundidad y el 

contenido de sedimentos que contribuyen el reflejar la energía cuando esta llega hasta 

las partículas o al fondo del agua. En el caso de la nieve, la reflexión disminuye a 

medida que la longitud de onda aumenta. Cuando se está trabajando con microondas 

la reflexión es muy alta nuevamente. 

 

2.1.10 CARACTERÍSTICAS GENERALES DEL SENSOR LANDSAT TM 

 

El sensor TM (Thematic Mapper) es un sensor óptico que opera en las 

regiones del visible y el infrarrojo. Este sensor ha estado a bordo de los tres últimos 

satélites del programa Landsat, el Landsat 4, Landsat 5 y Landsat 7, los cuales han 

permitido la cobertura continua de gran parte de la superficie de la tierra. Nosotros 

centraremos el análisis en el sensor TM a bordo de Landsat 7 ya que las imágenes 

utilizadas en el presente estudio pertenecen a dicho programa.  

 

El Landsat 7 (FIG. 2-28) fue lanzado en abril de 1999 con un nuevo sensor 

denominado ETM+ (Enhanced Thematic Mapper Plus). Una imagen Landsat 7 

ETM+ está compuesta por 8 bandas espectrales que pueden ser combinadas de 

distintas formas para obtener variadas composiciones de color u opciones de 

procesamiento. Entre las principales mejoras técnicas respecto de su antecesor, el 

satélite Landsat 5, se destaca la adición de una banda espectral (banda pancromática) 

con resolución de 15 metros.  

 

 También cuenta con mejoras en las características geométricas y 

radiométricas y una mayor resolución espacial de la banda térmica para 60 m. Estos 

avances tecnológicos permiten calificar al Landsat 7 como el satélite más interesante 

para la generación de imágenes con aplicaciones directas hasta una escala de 

1:25.000, principalmente en áreas rurales o territorios de grandes extensiones. 
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Las imágenes generadas por el Landsat7 adquiridas mediante el sensor ETM+ 

presentan una mejor relación costo-beneficio que los datos generados por satélites de 

resolución media ( 15 a 30 metros) actualmente ofrecidos en el mercado. 

 

 
FIG. 2- 28 Satélite Landsat 7. Tomado de.Goyo. IGVSB, 2008. 

 

              Los rangos espectrales y demás características generales para este sensor son 

mostrados en la Fig  2-29. 

 
FIG. 2- 29 Características generales del Sensor TM, Tomado de Chuvieco. 1990 
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2.1.11 PROCESAMIENTO E INTERPRETACIÓN DIGITAL DE IMÁGENES 

SATELITALES 

 

El procesamiento de imágenes esta relacionado con la corrección y calibración 

de las imágenes con el fin de conseguir una representación lo más fiel posible de la 

superficie de la tierra. 

 

Las imágenes de sensores remotos son tomadas frecuentemente a gran 

distancia de la superficie terrestre. Como resultado hay un gran camino atmosférico 

que la energía electromagnética debe atravesar antes de llegar al sensor. 

 

Dependiendo de la longitud de onda y de las condiciones atmosféricas la 

energía que llega al sensor puede ser modificada. Por consiguiente una variedad de 

turbaciones sistemáticas pueden combinarse para degradar la calidad de la imagen 

que nosotros recibimos finalmente.  

 
La restauración o corrección de la imagen tratan de mover esos efectos de 

degradación (Alzate, 2005), los cuales son: 

 

Preprocesamiento: antes de ser usadas, las imágenes requieren correcciones 

radiométricas, las cuales tienden a remover los efectos de los errores del sensor y de 

los factores ambientales (Alzate, 2001). 

 

Correcciones Radiométricas: Se refieren a la remoción o disminución de las 

distorsiones en el grado de energía electromagnética registrada por cada detector. 

Algunas de las distorsiones más comunes para las cuales existen procedimientos de 

corrección son (Alzate, 2001): 
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• Valores elevados uniformemente: debido a la neblina atmosférica, la cual 

preferencialmente dispersa las longitudes de onda corta (Alzate, 2001). 

 

• Bandeamiento: debido a los detectores que se encuentran sin calibración (Alzate, 

2001). 

 

• Ruido al azar: debido al desempeño no-sistemático e impredecible del sensor o de la 

transmisión de los datos (Alzate, 2001).  

 

Para estudiar patrones de reflectancia en diferentes tiempos o a través de 

mosaicos de imágenes, es necesario calibrar los valores de radiancia para que los 

niveles de reflectancia absolutas de los objetos medidos por diferentes sensores 

correspondan a través de imágenes separadas. Este procedimiento también puede ser 

requerido para normalizar los ángulos solares y las distancias Tierra-Sol (Alzate, 

2001). 

 

Calibración de la Radiancia: Los valores de los píxeles en imágenes 

comerciales representan la radiancia de la superficie en forma de números digitales 

(ND), los cuales son calibrados para ajustarlos en cierto rango de valores.  

 

La conversión del ND a radiancia absoluta es un procedimiento necesario para 

comparar imágenes tomadas por diferentes sensores. Cada sensor tiene sus 

parámetros de calibración usados para grabar los valores del ND (Alzate, 2001). 

 

Usualmente los detectores son calibrados para que haya una relación lineal 

entre el ND y la radiancia espectral. Esta función lineal es descrita por tres 

parámetros: el rango del valor del ND en la imagen, la mínima (Lmin) y la máxima 

(Lmax) radiancia medida por un detector sobre la banda espectral del canal. Lmin es 

la radiancia espectral correspondiente al valor del ND mínimo (usualmente 0). Lmax 

es la radiancia espectral correspondiente al máximo ND (usualmente 255). No 
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solamente cada sensor, sino cada banda dentro del mismo sensor, tiene su propio 

Lmax y Lmin. La información acerca de los parámetros de calibración del sensor es 

usualmente suplida con la imagen (Alzate, 2001). 

 

  
Efectos Atmosféricos: Las partículas atmosféricas y las moléculas causan 

efectos de dispersión en la transmisión de la energía, sobre todo en las longitudes de 

onda cortas. El efecto de la niebla es usualmente una elevación uniforme de los 

valores espectrales, en las bandas del visible del espectro electromagnético (Alzate, 

2001). 

 

Una de las formas de reducir la niebla en la imagen es ver los valores en las 

zonas donde se sabe que debe haber reflectancia cero, como en el agua profunda. 

Cualquier valor sobre cero en esas áreas probablemente representa un incremento en 

los valores de la imagen y puede ser sustraído fácilmente de todos los píxeles en las 

bandas individuales (Alzate, 2001). 

 

Efectos de Ruido: Los ruidos en las imágenes suceden debido a interferencias 

mecánicas en el sistema que conduce a errores de transmisión. El ruido puede 

degradar la señal registrada o virtualmente eliminar toda la información radiométrica. 

El ruido puede ser sistemático como el mal funcionamiento periódico de un detector, 

el cual resulta en el bandeamiento de la imagen. También puede ser más al azar, 

cuando causa variaciones radiométricas descritas como “sal y pimienta” debido a la 

apariencia que dan (Alzate, 2001). 

 

2.1.11.2 Extracción de Información 

La clasificación es el proceso de desarrollar mapas interpretados a partir de 

imágenes de sensores remotos. Los resultados de la clasificación marcan la calidad 

final del proyecto desarrollado (Alzate, 2001). 
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            Existen dos aproximaciones básicas para el proceso de clasificación: 

clasificación supervisada y no supervisada. Con la clasificación supervisada se 

provee una descripción estadística de la manera en la cual las coberturas de uso 

esperadas deberían aparecer en la imagen, después un procedimiento denominado 

clasificador, es usado para evaluar la probabilidad de que cada píxel pertenezca a una 

de esas clases (Alzate, 2001). 

 

Con la clasificación no supervisada es usado un enfoque muy diferente. Aquí 

un tipo especial de clasificador es usado para descubrir los patrones de reflectancia en 

la imagen, basado en que ellos representan las principales clases de cobertura y uso. 

Entonces se determina la identificación de cada clase por una combinación de 

experiencia y trabajo de campo (Alzate, 2001). 

 

            En ambos casos el proceso de clasificación puede ser visto como aquel que 

determina el conjunto al cual cada píxel pertenece. En el caso de la clasificación 

supervisada los conjuntos son conocidos (o se asume que son conocidos) antes que el 

proceso se inicie.  

 

Esta clasificación es por ello un proceso de toma de decisiones basado en la 

información disponible. Con la clasificación no supervisada, sin embargo, las clases 

son desconocidas, por eso el proceso se considera de segmentación de clases más que 

de toma de decisiones (Alzate, 2001). 

 

Como ya se mencionó anteriormente, cada material de la naturaleza tiene su 

propia interacción con la energía electromagnética. Esta interacción varía de una 

longitud de onda a otra dando lo que se conoce como un patrón de respuesta 

espectral. La base de la clasificación es encontrar algunas áreas del espectro 

electromagnético, en las cuales la naturaleza de esta interacción sea diferente para los 

materiales dentro de la imagen. Esto se define como firma espectral. Esto es, un 

patrón de respuesta espectral que es característico de un material (Alzate, 2001). 
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Clasificación Supervisada 

 
Parte de un cierto conocimiento de la zona de estudio, lo cual permite 

delimitar sobre la imagen unas áreas de entrenamiento que se consideran 

representativas. Tales áreas sirven para entrenar al computador en el reconocimiento 

de las diferentes categorías. A partir de ellas el computador calcula los valores 

radiométricos que definen cada una de las clases, para luego asignar el resto de los 

píxeles de una imagen a una de esas categorías en función de sus valores (Alzate, 

2001). 

 

La cartografía convencional o las fotografías pueden ser de ayuda para la 

localización precisa de estas áreas, las cuales deben ser lo suficientemente 

homogéneas y representativas de la clase que definen (Alzate, 2001). 

 
Clasificación No Supervisada 

 
Está dirigida a definir clases espectrales presentes en la imagen. No implica 

muestreo previo del área en estudio. En este método se asume que los valores 

radiométricos de los píxeles forman una serie de agrupaciones.  

Estos grupos corresponderán a píxeles con un comportamiento espectral 

homogéneo que definen diversas clases temáticas. Desgraciadamente estas categorías 

espectrales no siempre pueden equiparase a las clases de información que se pretende 

deducir, entonces toca interpretar o dar sentido temático a las categorías (Alzate, 

2001). 

 

 

2.2  CLASIFICACIÓN DE SUELOS POR ORDEN TAXONÓMICO 

  A continuación se presenta la clasificación taxonómica de los suelos, cuya 

nomenclatura obedece los criterios adoptados por el Sistema del "Soi1 Taxonomy 

(1973)". 
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2.2.1 Suelos del orden Entisol 

Son suelos minerales derivados tanto de materiales aluviónicos como 

residuales, de textura moderadamente gruesa a fina, de topografía variable entre plana 

a extremadamente empinada. No tienen horizontes de diagnóstico 1/. 

 

[1/ Los "horizontes de diagnóstico", son aquellos horizontes de suelos que tienen un 

grupo de propiedades cuantitativamente definidas y que sirven para identificar las 

unidades de suelos.] 

 

Son suelos montañosos predominantemente superficiales, y en la generalidad 

de los casos presentan afloramientos rocosos o pedregosidad superficial.  

 

2.2.2  Suelos del orden Inceptisol 

 
Los inceptisoles  son suelos derivados tanto de depósitos fluviales como 

residuales, y están formados por materiales líticos de naturaleza volcánica y 

sedimentaria. Son superficiales a moderadamente profundos y de topografía plana a 

quebrada.  

 

Morfológicamente presentan perfiles de formación incipiente, en los cuales se 

destaca la presencia de un horizonte cámbico (B) de matices rojizos a pardo 

amarillento rojizo, excepcionalmente pardo amarillentos, y con evidencias darás de 

alteración y no de acumulación de material iluviado.  

 

2.2.3  Suelos del orden Alfisol 

 
Tienen una saturación de base mayor de 35° y los horizontes subsuperficiales 

muestran evidencias claras de traslocación de películas de arcilla (clay skins).  
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2.2.4  Suelos del orden Molisol 
 
 

Son suelos superficiales a moderadamente profundos, con epipedón mólico, 

desarrollados de materiales volcánicos y sedimentarios; tienen horizontes 

superficiales oscurecidos, estructurados en gránulos bien desarrollados de 

consistencia friable y dotados suficientemente de bases, principalmente Ca y Mg. 

Presentan topografía que varía entre ligeramente inclinada a extremadamente 

empinada.  

2.2.5  Suelos del orden Ultisol 

 
Los ultisoles reconocidos tienen un horizonte argílico de poco espesor y un 

bajo porcentaje de saturación de base generalmente inferior a 25% dentro de la 

sección de control del perfil edáfico.  

 

2.2.6  Suelos del orden Oxisol 

 
La inclusión de los suelos dentro de este orden, y por consiguiente a nivel de 

suborden y de Grande Grupo debe ser considerado como provisional debido a los 

pocos datos de laboratorio referidos a análisis específicos para determinar las 

propiedades tóxicas.  

 

Entre las características más destacadas de los suelos identificados cabe 

mencionar: alta porosidad, muy friables, generalmente arcillosos, límites de horizonte 

difusos, muy desbasificados y saturación básica muy baja.  
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CAPÍTULO III 

GEOGRAFÍA FÍSICA 

 
En este capítulo se presentan las principales características del área de estudio, 

considerando los aspectos climáticos, topográficos, de suelos y de vegetación, con el 

fin de identificar los patrones  particulares de la región en cuestión.  

 

3.1 CLIMA 

 
Para caracterizar el clima del área se presentan los principales factores que las 

determinan, para luego describir las categorías climáticas presentes de acuerdo a la 

clasificación de Koeppen (1936). 

 

Las condiciones climáticas de la región tienen son influenciadas 

principalmente por los siguientes elementos: 

 

Latitud 

Definida por el movimiento aparente anual del sol, de sur a norte y viceversa, 

el cual origina una intensificación de la precipitación en la época de mayor 

verticalidad de los rayos solares sobre la región.  

 

Altitud 

La temperatura se ve modificada por la altura y a su vez  influye en la 

precipitación produciendo lluvias orográficas. Un ejemplo de ello, se puede observar 

en las zonas de montañas y altiplanicies que presentan cotas de más de 2000 m, en 

donde se experimenta un descenso en la temperatura de hasta 0.5 °C por cada 100 m. 
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Vientos 

Los vientos predominantes en la región provienen del noreste (época de 

menor precipitación) y sureste (época de mayor precipitación). 

 
Estos tres elementos son los que determinan fundamentalmente las 

características climáticas predominantes en el área, por lo que se puede resumir lo 

siguiente: 

 

De acuerdo a la Clasificación de Koeppen, se define el tipo de clima como  

tropical, que está definido por la franja norte que parte desde Puerto Ayacucho y 

sigue el curso del río Orinoco aguas abajo (MARNR, 2003).        

 

Las temperaturas medias mensuales oscilan entre los  25.2° C para el mes de 

Julio y los 28.6 °C en el mes de marzo, la promedio anual es de 26 °C (MARNR, 

2003)..  

 

El régimen de precipitación es unimodal, presentando los máximos de 

precipitaciones anuales entre los meses mayo y julio, siendo el mes de junio el mes 

mas lluvioso, alcanzando valores de más de 500 mm mensuales, el periodo de menor 

precipitación se presenta entre los meses diciembre y febrero, con precipitaciones por 

debajo de los 50mm, razón por la cual pueden considerarse meses secos de  desde los, 

(MARNR, 2003).  

 

De acuerdo al mapa de isoyetas medias anuales (FIG 3-0) la precipitación 

media anual a lo largo del área varía entre los 2200 mm y los 2900 mm, 

caracterizándose por presentar el aumento en dirección oeste-este, partiendo de la 

unidad de planicies hasta la unidad de altiplanicies. 
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FIG 3-0.  Mapa de Isoyetas correspondiente al área de estudio. Tomado y modificado del MARNR, 

2003.   

 Se pueden diferenciar 3 sectores de precipitación: el primero con valores de 

precipitación que oscilan entre los 2200 mm y 2600 mm, ubicados en la sección 

donde se encuentra distribuida la población (Oeste), dominado por los paisajes con 

alturas < a 400 msnm; el segundo constituido por la sección con precipitaciones que 

van desde los 2600 mm a los 2700 mm, caracterizado por presentar uniformidad 

durante el periodo de lluvia y se corresponde con los paisajes con alturas 

comprendidas entre 400 msnm y 720 msnm; y el tercero con valores de precipitación 

que varían entre 2700 mm y 2900 mm ubicados en la parte alta del río Cuao al este 

del área, localizado en los paisajes más elevados con aturas > 720 msnm (MARNR, 

2003).   
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Existe una relación inversamente proporcional entre la evaporación y la 

precipitación, es decir, que en el periodo comprendido entre mayo y julio que es 

cuando se  presentan las mayores precipitaciones, los valores de evaporación son los 

más bajos, por debajo de los 150 mm mensuales, correspondientes al mes de junio. 

Por otra parte, los meses de mayor evaporación corresponden al periodo de diciembre 

a marzo con valores de hasta 230 mm mensuales (MARNR, 2003).  

 

3.2 RELIEVE 

 
 El relieve en el estado amazonas forma parte apreciable del escudo de 

Guayana aunque no formando una cadena ininterrumpida de elevaciones, sino 

formando macizos aislados entre sí. Debido a la antigüedad de su geología y a los 

diferentes materiales que lo componen, el relieve se puede clasificar en una primera 

aproximación como plano y bajo, cubiertos por sabanas y selvas interrumpidas  por 

macizos (MARNR, 2003).  

 

 El sistema montañoso está constituido por una serranía de unos 70 km de 

longitud y está asociado a la existencia de macizos graníticos, altiplanicies y tepuyes 

el cual se extiende hacía el extremo noroccidental y se dirige en 2 direcciones, este y 

sur, encontrándose pequeños valles a lo largo de los ríos Parguaza y Cataniapo, que 

generalmente poseen una dirección noreste -suroeste, configurando de esta manera 

los límites con el estado Bolívar (MARNR, 2003).  

 

 En su mayoría el área estudiada está constituida por tierras bajas cubiertas por 

suelos residuales o aluviones, interrumpidas en ocasiones por colinas de elevaciones 

menores a los 900 m de altura (hacía el sur-oeste) provenientes de restos de domos 

graníticos, parcialmente alterados, de los cuales algunos tienen su origen en el 

desarrollo de “Inselbergs” (Yañez, 1973). 
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3.3 SUELOS  

 Los suelos en la región en su mayoría se han originado del desgaste de 

materiales correspondientes a las formaciones más antiguas de Venezuela. Una de 

estas es el Granito de Parguaza, el cual se originó en el Precámbrico y su edad se 

calcula entre los 1300 y 1825 ma.  

 

 Estos suelos han sido sometidos a un intenso proceso de meteorización y 

lixiviación a través de su historia geológica, causado por las elevadas precipitaciones 

y temperaturas ambientales. 

 

Los granitos y demás rocas ácidas constituyen la base mineralógica, mientras 

que las altas temperaturas y la cuantiosa pluviosidad han actuado como agentes de 

disgregación mecánica y transformación físico-químico, transporte y depositación de 

sedimentos durante largos periodos geológicos (Sistemas Ambientales Venezolanos; 

MARNR, 1983).  

 

Por su edad y condiciones climáticas imperantes, la mayoría de estos suelos 

han soportado en su desarrollo un proceso de ferratilización muy avanzado, el cual se 

caracteriza por la lixiviación de sílice y la descomposición de las arcillas en 

caolinitas, óxidos de hierro y aluminio hidratado (Sistemas ambientales Venezolanos; 

MARNR, 1983). 

 

 Según el sistema de la clasificación de “US Soil Taxoomy,USDA”, los suelos 

del área corresponden principalmente a tres órdenes: Entisol, Ultisol e Inceptisoles. 

Las características de los suelos en la región están estrechamente relacionadas 

con los aspectos climáticos, hidrográficos, geológicos y geomorfológicos, y en gran 

parte determinan la diversidad de la vegetación de esta región.  

 

En función de lo antes expuestos se tienen diferentes tipos de suelos para las 

distintas categorías de paisajes, representados de la siguiente manera (FIG. 3-1): 
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FIG. 3- 1 Mapa de Unidades de Suelos del estado Amazonas. Tomado y Modificado del MARN, 2003. 

El rectángulo rojo muestra el área de estudio del presente trabajo. 
 

Las principales características de los suelos predominantes son: 

 

3.4.1 ENTISOLES 

 
Es el tipo de suelo de mayor abundancia en el área de estudio, con un 

porcentaje aproximado de 48 %, ubicados al sureste - noreste de la zona, se 

caracteriza por tener un escaso desarrollo evolutivo, ya que su origen es reciente. Esto 

se observa en aquellos suelos formados a partir de materiales coluvio-aluviales y 

aluviales. 
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Litológicamente, está asociado a rocas de la Provincia Geológica de 

Cuchivero, así como también a sedimentos de origen Coluvio-aluviales y aluvial del 

Cuaternario. 

 

Estos suelos pueden ser moderadamente profundos a muy profundos (> 

100cm), y en ocasiones pueden llegar a ser superficiales (5-40cm), de textura fina; se 

presentan bien drenados en el área de montaña y menos drenado al llegar a las áreas 

de mayor depresión.  

 

3.4.2 ULTISOLES 

 
Constituye el segundo orden de mayor abundancia en el área a estudiar con un 

porcentaje aproximado de 42%, se caracterizan por ser suelos con un avanzado 

desarrollo debido a los intensos procesos de meteorización de la roca. Estos suelos 

presentan acumulación de materia orgánica y se encuentran localizados en el paisaje 

de planicies y mesetas, específicamente al suroeste, noroeste y parte sureste del mapa 

generando procesos de enriquecimiento de bases superficiales, como consecuencia de 

la descomposición de los restos vegetales presente en zonas depresionales, bajo 

condiciones de saturación permanente. 

  

3.4.3 INCEPTISOLES  

 Se consideran el tercer orden de abundancia en la zona con un porcentaje 

aproximado de 15%. De acuerdo a que estos son suelos se destacan por su bajo o 

moderado desarrollo evolutivo. 

 

 Este tipo de suelo se encuentra ubicado en el paisaje de planicie caracterizados 

por ser: superficiales (menores de 25 cm), moderadamente profundos (de 50 a 

100cm) y ocasionalmente muy profundo (mayores de 150 cm) de textura fina a 

gruesa. El riesgo a la erosión está limitado por las bajas pendientes y por la presencia 

de una cobertura selvática. 
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Químicamente son suelos de baja fertilidad natural, donde el drenaje es denso 

a excepción de las áreas depresionales donde el drenaje es escaso.  

En cuanto a su litología, se puede decir que este tipo de suelo se encuentra 

asentado en materiales no consolidados, que corresponde a depósitos recientes del 

Cuaternario, ubicados en los márgenes del río Orinoco al noroeste del área de estudio. 

 

En general los suelos del área son muy pobres y delgados,  juegan el papel de 

soporte mecánico de la vegetación, por cuanto los ciclos de nutrientes son casi 

externos al suelo, desarrollándose en la biomasa vegetal. En ellos solo el horizonte 

superficial, que a menudo es muy delgado,  son fértiles por la presencia de material 

orgánico en la superficie, lo que aumenta la capacidad de intercambio y es el único 

componente que interviene para modificar su pobreza química. El contenido de 

carbono en la superficie es del orden del 0,4% y el pH es casi siempre más ácido en la 

superficie que en la parte interna (Sistemas Ambientales Venezolanos; MARNR, 

1983). 

 

3.5 VEGETACIÓN 

 
En el área se puede observar el desarrollo de formaciones vegetales adaptadas 

a las condiciones de temperatura, humedad, suelo y fisiografía. De acuerdo a la 

reciente publicación del Plan de Ordenamiento Territorial del Municipio Atures - 

estado Amazonas, por MARNR, 2003; se pueden distinguir  para la región seis 

diferentes tipos de vegetación, como lo son los bosques y Sabanas distribuidas de la 

siguiente manera: (FIG. 3-2): 
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FIG. 3- 2 Mapa de Unidades de Vegetación del estado Amazonas. Tomado y Modificado del MARN, 

2003. El rectángulo rojo muestra el área de estudio del presente trabajo. 
 
 

3.5.1 BOSQUES 

 
De acuerdo a C.V.G Tecmin (1994), esta formación vegetal corresponde a 

zonas bioclimáticas Tropófilo Macrotérmico, es decir, un bioclima seco tropical de 

bosques medio denso a bajo denso, y Ombrófilo Macrotérmico, es decir bioclima 

húmedo tropical de bosques medio denso a bajo ralo. Se presentan esencialmente en 

los paisajes de planicies, mesetas y lomeríos. 

 

Los bosques desarrollados en los paisajes de planicies se encuentran cercanos 

al río Orinoco y a los márgenes del mismo hacía el noroeste y suroeste del área.  
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Estos son bosques de cobertura vegetal media y alturas variables de carácter 

siempre verde, lo cual viene dado por el régimen de inundación de los suelos, 

pudiendo alcanzar alturas de 8 a 16 m en áreas sujetas a inundaciones en periodos 

largos, y alturas de 20 a 26 m en áreas de drenaje denso hacía los márgenes del río 

Orinoco.  

 

 Se caracterizan por presentar suelos del tipo Entisol y Ultisol, con presencia 

de afloramientos rocosos. También se pueden encontrar formaciones boscosas de 

características bajo denso o bajo ralo, con incrustaciones de sabanas, arbustales y 

morichales. 

 

Los bosques desarrollados en paisajes más elevados como montañas y mesetas 

localizados hacia el noreste y noroeste del área de estudio, se caracterizan por 

presentar bosques bajo denso y medio denso con arbustales, que pueden alcanzar 

alturas comprendidas entre los 18 y 30 m, intercalados con vegetación siempre verde. 

 

Los bosques localizados hacía el suroeste y la parte central del área están 

asociados principalmente a paisajes de Lomerios y Peniplanicies, estos presentan una 

composición de bosques medio denso de cobertura variable (densa a rala) y 

asociaciones de bosques bajo denso y bajo ralo, que en algunos casos tienden a 

relacionarse con sabanas graminosas arbustivas. Presentan una altura media de 16 a 

25 m, y pueden alanzar hasta los 28 y 40 m. 

  

3.5.2 SABANAS  

 
 Este tipo de formación herbácea se desarrolla en las zonas bioclimáticas 

Tropófilo Macrotérmico y Ombrófilo Submesotérmico que conforman el paisaje de 

planicie extendida a lo largo del margen derecho del río Orinoco, al oeste del área de 

estudio. 
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Estas sabanas se caracterizan por presentar una cobertura que varía de densa a 

rala, con una altura inferior a los 1.5 m dominados principalmente por gramíneas de 

tipo llanero, eventualmente puede presentar otras hierbas bajas y árboles ( C.V.G 

Tecmin,1994). 

 

3.5.3 VEGETACIÓN EN LAJAS  

 
 Según C.V.G Tecmin (1994), este término está relacionado con los 

afloramientos rocosos de granitos con forma de “Inselberg”, conocidos localmente 

con el nombre de “lajas” los cuales están presentes hacía el suroeste y parte central 

del área, donde se han desarrollado cierta vegetación herbácea – arbustivo, adaptada a 

las condiciones mínimas de disponibilidad de nutrientes, cuya diversidad, densidad de 

cobertura y altura dependen del tamaño de las grietas y depresiones existentes en los 

afloramientos. De esta manera, las coberturas varían desde pequeñas manchas de 

vegetación pionera hasta sabanas graminosas e incluso bosquecillos. Estos últimos 

contienen árboles de hasta 8 a 10m de alto, la mayoría de ellos deciduos, sobre una 

capa del suelo (específicamente del tipo Entisol) relativamente delgada.   

 La vegetación pionera ocupa pequeñas depresiones o grietas, estando formada 

por un estrato herbáceo de hasta 80-100 cm, y un estrato totalmente deciduo. 
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CAPÍTULO IV 

 
ANTECEDENTES Y GEOLOGÍA REGIONAL 

 
Los trabajos previos que se obtuvieron como resultado de una investigación de 

antecedentes en la zona de estudio, se citan a continuación: 

 

Mc CANDLESS (1966) describe las características geológicas principales 

entre el río Orinoco y el paralelo 6° en donde describe por primera vez la unidad 

desde entonces denominada Granito de Parguaza, que es la que aflora en el área de 

estudio. La define como una masa granítica intrusiva de carácter biotítico, 

homogéneo, de grano grueso, con textura porfidítica marcada y peculiar, que aflora 

desde el río Suapure en dirección Sur-Oeste hacía las zonas de Puerto Ayacucho, 

margen izquierda del río Orinoco en Colombia y parte noroeste del Territorio Federal 

Amazonas (ahora estado Amazonas), ubicándose sus mejores afloramientos en el 

raudal de Maracas en río Parguaza y en los Domos de Pijiguao, distrito Cedeño, 

estado Bolívar. 

 

Describe a el granito del Parguaza como una roca holofanerocristalina, sub-

idiomórfica granular, de grano muy grueso, inequigranular, maciza, con textura 

rapakivi, constituido por cuarzo (20%), feldespato potásico (40%), oligloclasas 

(25%), biotita (7%), hornablenda (8%) y cantidades menores de clinopiroxeno, 

fluorita, apatito y opacos. Alrededor de 10% de los fenocristales muestran zonación 

múltiple y el feldespato potásico es pertita microclino, a diferencia de otros “Granitos 

rapakivi” los cuales contienen ortosa. 

 

Por la mineralogía y ausencia de texturas gráficas y mirmequíticas se piensa 

que el Granito del Parguaza es post-tectónico o atectónico del tipo “seco”, formado a 

profundidades del orden de 15 a 20 Km.  
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MCCONNELL (1968). Realiza un estudio detallado sobre las superficies de 

planación en guyana y define 6 superficies las cuales han sido datadas y 

correlacionadas con superficies similares en África, Brasil y Surinam. 

 

MARTÍN (1972) realizó la interpretación paleotectónica del Escudo de 

Guayana en base a la inter-relación de parámetros petrológicos, geoquímicos, 

estructurales, metamórficos, geocronológicos y paleomagnéticos; analiza las diversas 

removilizaciones graníticas y eventos termales. 

 

MENDOZA (1972) define el granito de Pijiguao, como un granito 

leucocrático de color rosado salmón, grano fino, equigranular, macizo, de aspecto 

subvolcánico, expuesto en la base del Domo de Pijiguao. Su textura es poiquilítica de 

aspecto moteado recristalizada, superimpuesta a una textura hipidiomórfica granular 

con la siguiente mineralogía: cuarzo (30%), microclino (40%), albita (20%) y 

cantidades menores de biotita, epidoto, titanita, opacos, clorita. En base a su alto 

contenido de cuarzo y feldespato potásico, escasez de máficos (biotita) y ausencia 

total de hornablenda y piroxeno, se ha postulado al Granito como una facies de borde  

o una diferenciación más acida y de gran fino del Granito del Parguaza. 

 

El Granito de Pijiguao también podría ser equivalente a los granitos de grano 

fino y microgranitos asociados al granito de Guaniamito del Grupo Cuchivero (ahora 

Asociación Cuchivero). 

 

PASQUALI et al.,(1972) realizó, por primera vez, el estudio sobre la 

meteorización en ambiente tropical de rocas graníticas, riodacitas y anfibolitas del 

Granito de Paragua, estado Bolívar. 

 

El propósito del estudio fue determinar la distribución de los elementos 

principales de la roca fresca hasta la superficie cuando el granito meteoriza, y 

establecer un modelo mediante el cual pudiera explicar la meteorización del granito 
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en los ambientes de selva y sabana. Realizaron 16 calicatas en el granito para evaluar 

la variación en su perfil de meteorización de acuerdo a los cambios de desnivel, 

topografía, ambiente vegetal, predominio o ausencia del mismo (selva y sabana) y su 

variación con la profundidad. 

 

TALUKDAR Y COLVÉE (1973) señalan la posible presencia del “Complejo 

de Imataca” y del “Supergrupo Pastora” como basamento previo a la gran orogénesis 

durante la cual se desarrolló el Grupo Cuchivero. Esa orogenia del tipo andino se 

extendió según esos autores entre los 1400 y los 1600ma, en base a determinaciones 

radimétricas por los métodos K-Ar y Rb-Sr en roca total. Datos más recientes 

(MENDOZA, 1973,1975) contradicen lo postulado por TALUKDAR Y COLVÉE 

(1973). 

 

SZCZERBAN (1974) estudió la geología y petrología de la región de Puerto 

Ayacucho, Territorio Federal Amazonas (ahora estado Amazonas). Centró su 

atención en las rocas ígneas que afloran en el área, ya que los otros tipos de rocas 

presentes están constituidas por aluviones y suelos, estos residuales originados a 

partir de las rocas ígneas ácidas.   

 

Las rocas ígneas del área forman parte de un gran batolito de unos 280 x 150 

km, constituido por rocas ígneas ácidas, de composición granítica, altamente 

feldespática que se caracterizan por presentar la típica textura rapakivi, denominado 

Granito de Parguaza. 

 

Es un batolito de origen magmático, siendo el magma original rico en K y 

volátiles, cristalizado a altas presiones de agua, diferentes profundidades, emplazado 

en la epizona y origenéticamente post- tectónico.  
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Presenta pequeños cuerpos de granito de grano fino originado por 

cristalización de líquidos residuales del mismo magma, y de granito moteado 

producto posiblemente de la asimilación de rocas cuarzosas estratificadas. 

  

La edad del Granito de Parguaza está alrededor de los 1500 ma, presenta 

intrusiones y xenolitos de roca de la Formación Cinaruco.  

 

TALUKDAR Y COLVÉE (1975) reagruparon rocas volcánicas, granitos y 

rocas intermedias, tectonizadas y no tectonizadas como “Grupo Cuchivero” (1400-

1900 ma). 

 

MENDOZA (1972, 1973,1975) introdujo el concepto de Supergrupo Cedeño 

para dos grandes grupos de rocas graníticas, aflorantes en el área del río Suapure. 

Cada uno de estos grupos presenta trenes estructurales y geoquímicos, caracteres 

petrográficos, edades radimétricas y relaciones iotópicas Sr87/ Sr86 iniciales, muy 

diferentes. En efecto, el Supergrupo Cedeño está integrado por el Grupo Cuchivero 

(RIOS, 1969) y el Grupo Suapure (MENDOZA, 1972), los cuales están separados por 

metabasitas. El Grupo Cuchivero está constituido por la Formación Caicara 

(volcánicas y piroclásticas ácidas) y por los granitos leucocráticos de Santa Rosalía y 

San Pedro (levemente foliados).  

 

La edad del Grupo Cuchivero está próxima a los 1950 ma establecido por el 

método Rb/Sr roca total isocrona (GAUDETTE y otros, 1977). El Grupo Suapure 

está formado por granitos anorogénicos, masivos, ricos en máficos (hasta 25% entre 

biotita y hornblenda ± piroxenos), de grano grueso, textura rapakivi, escasamente 

recristalizados (granitos de Parguaza) y por granitos de grano fino-medio, masivos, 

sin hornblenda (granitos de los Pijiguaos). El granito del Parguaza presenta edad de 

1550ma por métodos Rb-Sr roca total isocrona y U-Pb en zircones. Así pues las rocas 

del Grupo Cuchivero son sin-tectónicas tardías y se originaron durante la orogénesis 

Transamazónica (HURLEY, 1973), mientras que los granitos del Parguaza son 
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anorogénicos y parecen representar un gran evento termal de extensión continental 

(HURLEY y otros, 1973; GAUDETTE y otros, 1977) que varios autores 

denominaron Parguazensis (MARTÍN 1972, GAUDETTE y otros, 1977). Es probable 

que el evento Parguazensis sea hasta de extensión transcontinental, como lo sugieren 

las grandes similitudes geológicas con los granitos Rapakivi de Finlandia. 

 

 BLANCANEAUX, P. POUYLLAU, M. (1976) realizaron un estudio pedo-

geomorfológico sobre las formaciones graníticas de la región de puerto ayacucho, 

estado amazonas, donde se hace una interpretación en cuanto a los suelos y a la 

geomorfología. 

 

MENDOZA (1977) realizó una excursión geológica al Territorio Federal Amazonas 

(ahora estado Amazonas), con el objetivo de mostrar el frente tectónico, o probable 

sutura que está localizada entre San Fernando de Atabapo y Santa Bárbara (Río 

Orinoco).  

 

Esta zona, de 90 km de longitud por unos 2-5 km de ancho, separa dos 

provincias petrotectónicas (FIG. 1-2), con características litológicas, lineamientos 

estructurales, grado metamórfico y caracteres geomorfológicos contrastantes. 

 

La primera que se describe es la provincia petrotectónica de Ayacucho, al 

norte de la zona de sutura, está constituida por granitos post-tectónicos o 

anarogénicos del tipo Parguaza (1550 m.a), con granodioritas del Sipapo y riodacitas 

del Guayapo, secuencia que intrusiona un basamento de rocas volcano (piroclásticas) 

ácidas y granitos sintectónicos del tipo Grupo Cuchivero del transamazónico (1950 

m.a). Predominan los lineamientos estructurales en dirección N50-60E, los cuales son 

cortados y desplazados por los de dirección N30-40W. El relieve de esta parte del 

Amazonas es el más abrupto y accidentado, el drenaje es enrejado y dendrítico. 
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Por otra parte, la provincia petrotéctonica de Casiquiare al sur de la sutura, 

está integrada por rocas plutónicas intermedias que varían de cuarzo-monzonitas y 

trondjemitas a tonalitas, dioritas y gabros, con textura gneisica bien desarrollada y 

frecuente presencia de migmatítas del tipo complejo Supamo. Los lineamientos 

estructurales predominan en las direcciones N 50- 60 E y E-W, es una provincia es 

sumamente plana (“plenillanura de Casiquiare”) y el drenaje es enrejado. 

 

 
FIG. 4- 1 Mapa de Provincias Petrotectónicas del Territorio Federal Amazonas. Tomado de Mendoza 

(1977), V Congreso Geológico Venezolano. 
 

MENDOZA (1977) publica el trabajo “Evolución Tectónica del Escudo de 

Guayana” donde define las provincias geoestructurales de Bolívar, Ezequibo, 

Amazonas y Canaima con carácter más regional que las anteriores divisiones y 

reconoce también cuatro de los cinco ciclos tectotermales (orogénesis) del 

precámbrico reconocidos a nivel mundial: a. Guriense (3600-2700 ma); b. 



GONZÁLEZ Y MILLÁN                                                    ANTECEDENTES Y GEOLOGÍA REGIONAL 

 

59 
 

Guayanense (2600- 2100 ma); c. Transamazónica (2000 – 1700 ma) y d. Orinoquense 

(1200 – 800 ma). 

 

El Grupo Roraima y el Granito del Parguaza de las provincias de Canaima y 

Amazonas respectivamente, las consideró como unidades atectónicas, originadas en 

el período inter-orogénico Transamazónico-Orinoquense. 

 

 

La edad de cristalización del Grupo Suapure ha sido calculada por Guadette 

(1977) en 1545 ± 20 ma por el método U – Pb en zircones y de 1521 ± 39 ma por el 

método Rb-Sr en roca total isócrona, con reactivación alrededor de los 1250 ma. 

 

 BRICEÑO, H. (1984) realizó un estudio en la zona de puerto ayacucho a 

través de las imágenes landsat 5 en donde hace una integración entre las imágenes 

satelitales y fotografías aéreas como parte de su trabajo de ascenso. 

 

SCHUBERT y BRICEÑO (1990) realizaron el estudio de la geomorfología en 

la gran sabana, en donde describen dos superficies de planación que son preservadas 

en la zona y las comparan con otras superficies descritas en sur América. 

 

CHALBAUD (2000) hizo estimaciones del espesor cortical del Escudo de 

Guayana mediante dos modelos bidimensionales de la corteza. El primero en 

dirección este-oeste paralelo al río Orinoco, se extiende 600 km desde el Callao hasta 

Caicara; el segundo presenta dirección norte-sur, cubre la región sur de la Cuenca 

Oriental de Venezuela y el sur del poblado de Ciudad Piar. 

 

 A los fines de la interpretación a realizar en esta investigación, es conveniente 

precisar que el modelo bidimensional este-oeste (FIG. 1-2) se caracteriza por 

presentar dos capas que constituye la corteza superior, tres capas dentro de la corteza 

inferior y parte del manto superior.  
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FIG. 4- 2 Modelo Geológico del Escudo de Guayana, paralelo al río Orinoco. Tomado de 

CHALBAUD (2000). 
 

 

MENDOZA (2005), presenta un resumen actualizado de la fisiografía de las 

provincias geológicas de Venezuela, mediante una recopilación de publicación y 

trabajos de grado actualizados, incluyendo los recursos minerales de Guayana en 

Venezuela y relacionándolas con la evolución geotectónica de cada provincia a lo 

largo de todo el territorio nacional.  

 

 

C.V.G TECNICA MINERA C.A (s/f), realizó un mapa en base a la 

interpretación geológica de las hojas NB-19-11 (Puerto Ayacucho) y NB-19-12 (Río 

Parguaza) a escala 1: 250.000. ( Fig 1-4) 
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FIG. 4- 3 Mapa Geológico de la Región Puerto Ayacucho y Río Parguaza, de las Hojas NB-19 11 y 12. 

Tomado de C.V.G Tecmin 
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GEOLOGÍA REGIONAL 

 

4.1 GENERALIDADES 

 
El Escudo de Guayana se localiza al sur del río Orinoco y ocupa 

aproximadamente el 50% de la superficie de Venezuela, con rocas tan antiguas como 

3.41 Ga (granulitas y charnockitas del complejo de Imataca) y tan jóvenes como 711 

Ma (kimberlitas eclogiticas de Guaniamo), que registran en buena parte una 

evolución geotectónica similar a la de otros escudos precámbricos en el mundo, con 

al menos ruptura de supercontinentes en 2.4-2.3 Ga (Guayanensis), 1.6-1.5 Ga 

(Atlántica-Caura), 0.8-07 Ga (Rodinia) y 0.2 Ga (Pangea). (Mendoza, 2005) 

 

4.2 PROVÍNCIAS GEOLÓGICAS DEL ESCUDO DE GUAYANA 

(MENDOZA, 2005). 

 

En particular, el Escudo de Guayana, que se compone de las Provincias 

Geológicas de Imataca, Pastora, Cuchivero y Roraima, (FIG.ura 4-1), forma parte del 

Cratón Amazónico del precámbrico de Sur América, que se extiende por el norte de 

Brasil, las Guayanas, remanentes precámbricos de Colombia y de Bolivia y estaba 

unido a África occidental hasta la ruptura de la Pangea, hace unos 200 Ma. 

(Mendoza,2005). 



GONZÁLEZ Y MILLÁN                                                    ANTECEDENTES Y GEOLOGÍA REGIONAL 

 

63 
 

 
FIG. 4- 4  Mapa de Provincias Geológicas del Escudo de Guayana. Tomado y modificado de 

Mendoza, 2005 
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4.2.1 PROVINCIA GEOLÓGICA DE IMATACA 

 
 Esta situada al extremo Norte de la Guayana Venezolana. Se extiende en 

dirección suroeste-noreste desde las proximidades del Río Caura hasta el delta del 

Orinoco y en dirección noroeste-sureste aflora desde el curso del río Orinoco hasta la 

falla de Guri por unos 550 Km y 80 Km, respectivamente. Presenta una edad de 2.24 

Ga. Petrológicamente pertenece al Cinturón Granulítico. Está formada por gneises 

graníticos y granulitas félsicas (60% - 75%), anfibolitas y granulitas máficas, y hasta 

ultramáficas (15% - 20%), y cantidades menores complementarias de formaciones 

bandeadas de hierro (BIF), dolomitas, charnockitas, anortositas, granitos intrusivos 

más jóvenes y remanentes erosiónales con menor grado de metarmorfismo y más 

jóvenes CRV-TTG gnéisicos. 

 

 Las rocas de alto grado metamórfico se interpretan como evolucionados 

primitivos Cinturones de Rocas Verdes y complejos graníticos potásicos y sódicos, 

varias veces tectonizados y metamorfizados hasta alcanzar las facies anfibolita y 

granulita y sufrir luego parcialmente metamorfismo retrógrado, registrando toda la 

historia evolutiva del escudo (Mendoza, 1.974). 

 

 La provincia Imataca registra seis o más dominios tectónicos, separados entre 

sí por grandes fallas tipo corrimientos. Internamente el plegamiento es isoclinal con 

replegamiento más abierto. En la parte norte, los pliegues tienen rumbo noroeste 

mientras que en la parte sur la tendencia dominante de los pliegues es N 60°-70°E 

que es la que predomina regionalmente, es decir aproximadamente paralelas a la falla 

de Guri. 

 

 Algunos gneises, considerados sin evidencia alguna como metasedimentarios, 

fueron datados en roca total por Rb/Sr y Pb/Pb como en 3.7-3.4 Ga. Rocas del 

Complejo de Imataca fueron tectonizadas y deformadas, intrusionadas y 

metamorfizadas alrededor de los 2.8-2.7 Ga (migmatita de la ceiba) y luego durante la 



GONZÁLEZ Y MILLÁN                                                    ANTECEDENTES Y GEOLOGÍA REGIONAL 

 

65 
 

Orogénesis transamazónica cuando fueron metamorfizadas de nuevo hasta alcanzar la 

parte superior de la facies anfibolita y la facies granulita de dos piroxenos (Sidder y 

Mendoza, 1.995). 

 
4.2.2 PROVINCIA GEOLÓGICA DE PASTORA  

 
Esta provincia se ubica al sur de la Provincia Imataca Se extiende desde la 

Falla de Gurí al norte hasta las proximidades del Parque Nacional Canaima al sur (km 

95 carretera El Dorado-Santa Elena), por el este hasta los límites con la zona en 

reclamación del Esequibo, al oeste hasta el río Caura y al sur está limitada por la 

provincia Roraima. Presenta una edad de aproximadamente 2094-1984 ma.  

 

Estos complejos suelen estar tectonizados, metamorfizados y son pre-

Transamazónicos, pero otros no muestran casi tectonismo ni metamorfismo y son 

post-Transamazónicos de la Suite Avanavero. 

 

4.2.3 PROVINCIA GEOLÓGICA DE CUCHIVERO-AMAZONAS.  

 
La Provincia de Cuchivero parece extenderse hacia el sur-sureste en el estado 

Amazonas, formando gran parte de las rocas del no diferenciado Proterozoico según 

Sidder y Mendoza (1.995). Aprox. 1.9 G.a – 1.8 G.a. Post Orogenesis 

Transamazonica. 

 

 Esta provincia geológica de Cuchivero incluye rocas volcánicas rioliticas y 

asociadas, comagmaticas con granitos calcoalcalinos de la Asociación Cuhivero; 

areniscas, conglomerados, limolitas, tobas y lutitas del Grupo Roraima; sills, diques, 

apófisis, stocks de rocas diabásicas-gabronoriticas cuarcíferas de la Asociación 

Avanavero, el Granito Rapakivi de El Parguaza y complejos alcalinos como el de La 

Churuata y rocas asociadas, así como intrusiones de Carbonatita de Cerro Impacto, 

lámprofiros y kimberlitas eclogiticas de Guaniamo.  
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UNIDADES LITODEMICAS ASOCIADAS A LA PROVINCIA GEOLOGICA 

CUCHIVERO-AMAZONAS 

 
Dentro de estas unidades se describirán las Superasociación Cedeño con 

contienen la Asociación Cuchivero y Asociación Suapure. 

 

SUPERASOCIACIÓN CEDEÑO 

 
 Esta compuesta por las siguientes unidades: 

 

ASOCIACIÓN CUCHIVERO 

 
La Asociación Cuchivero, fue definida por Ríos (1972) como compuesto de rocas 

volcánicas riolíticas de las Volcánicas de Caicara, y de los ranitos biótiticos de Santa 

Rosalía, horablénditicos de Guainiamito, el Granito de San Pedro y las Metabasitas, 

descritos a continuación:  

 

Volcánicas de Caicara 

 
 Litológicamente se compone de tobas de cenizas,  brechas y cantidades 

menores de lavas, obsidianas y domos riolíticos, con cantidades muy subordinadas de 

otras rocas volcánicas de composición dacitica, andesitica y aún basálticas, todas ellas 

de afinidad calcoalcalinas. 

 

 Esta unidad fue definida por Ríos (1969) en una sección transversal a la 

serranía o “fila” de Morichal Negro, hacienda Santa Inés, en la vía a Guaniamo, a 

unos 30 km. al sur de Caicara del Orinoco, distrito Cedeño, estado Bolívar. 
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Granitos biotíticos de Santa Rosalía 

 
 Este Granito es de grano medio a grueso, aproximadamente equigranular, con 

biotita, escasa a ausente hornblenda. 

 

 Aflora extensamente desde la Serranía El Mato en el Caura al pueblo de Santa 

Rosalía, al este, hasta el río Suapure al oeste y hasta el río Ventuari al sur. 

 

Granitos Hornablendíticos de Guaniamito 

 
 Es un granito hipoabisal, porfidico, rico en hornblenda, con textura gneisica 

gruesa bien desarrollada hacia la zona de la Falla de Cabruta y su edad Rb-Sr roca 

total dio 1425 ma equivalente al Parguaza, aunque tectonizado y convertido en gneis 

por la falla de Cabruta. Aflora más localmente en el caño del mismo nombre y en el 

Río Guaniamo. 

 

Granito de San Pedro 

 
 Es un granito subvolcánico, de grano fino,  facies del Granito de Santa 

Rosalía. Aflora cerca del paso San Pedro en el río Suapure. 

 

Metabasitas 

 
 Son rocas volcánicas de composición máfica (basáltica a andesitica) alteradas 

deutéricamente o metamorfizadas levemente. Afloran en la región del Alto Supamo. 

Las áreas de afloramiento son pequeñas por lo que no se ha podido establecer una 

relación entre sus diferentes tipos. 
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ASOCIACIÓN SUAPURE 

 
La Asociación Suapure fue definida por Mendoza (1974) como compuesto por 

el Granito de Pijiguaos y el Granito de El Parguaza. Descritas a continuación: 

 

Granito de Pijiguaos 

 
 Es un granito de grano fino, equigranular, aspecto algo recristalizado 

“parcialmente horneado por el Granito Rapakivi de el Parguaza”, muy rico en cuarzo 

y microclino, con textura moteada en la que se observan dos o más generaciones de 

cuarzo, posiblemente correspondientes con las pulsaciones o intrusiones inmediatas 

posteriores del Granito Rapakivi de el Parguaza.  

Aflora en la mitad inferior de los domos del mismo nombre, en contacto no 

transicional con el Granito Rapakivi de el Parguaza. 

 

Granito Rapakivi del Parguaza 
 
 Es una roca masiva, de colores grises, de grano muy grueso, textura 

inequigranular wiborgita rapakivi con bajo a moderado contenido de cuarzo (5%-

20%) alto de microclino-pertita (25% - 55%), moderado de oligoclasa (15% - 30%) y 

notorio de minerales máficos enriquecidos en Fe0 (biotita 3% - 17%, hornblenda 1- 

24% ± clinopiroxeno) con cantidades menores de magnetita, ilmenita, circón y 

fayalita. Son rocas metaluminosas a  peraluminosas, de afinidad toleitica, ricas en Fe, 

K, Rb, Ni, Th, F, RE., Es, muy bien fraccionadas.  

 

 Ocupa una gran superficie desde los Pijiguaos al Este hasta Puerto Ayacucho 

al Oeste y desde el Río Orinoco al Norte hasta la  confluencia del Rio Ventuari con el 

Orinoco en Amazonas, al Sur, con forma elipsoide de 250 km de eje NS por 120 km 

de eje este-oeste. 
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4.2.4  PROVINCIA GEOLÓGICA DE RORAIMA.  

 
La Provincia Geológica de Roraima se extiende desde los límites del Parque 

Nacional Canaima, hacia el Km 95 cerca de la Piedra de la Virgen, hasta Santa Elena 

del Uairen en dirección norte-sur y desde el río Venamo hasta las proximidades del 

río Paragua en dirección este-oeste. Su edad esta datada en 1800 ma. 

 

Reíd (1974) dividió el Grupo Roraima en el área de Santa Elena del Uairén en 

cuatro formaciones, que de más antigua a más joven, son: Uairén, Kukenan, 

Uaimapué y Mataui. Mayormente distinguidas por ser secuencias sedimentarias.  

 

Las rocas de Roraima no muestran metamorfismo regional. Sólo se registra 

metamorfismo de contacto (andalucita) de rocas de Roraima con granitos intrusivos, 

post-1450 ma, y de rocas máficas de la Asociación Avanavero; Urbani, (1977) 

postuló un metamorfismo de carga (pirofilita) en algunas localidades del Alto Caura 

posiblemente donde el Grupo Roraima alcanzó otros 3000 m adicionales de 

sedimentos actualmente erosionados. 

. 
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UNIDADES LITOESTRATIGRAFICAS ASOCIADAS A LA PROVINCIA 
GEOLOGICA DE RORAIMA 

 
FIG. 4- 5 Tomado y modificado de Mendoza (2005) 
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4.3 TECTÓNICA REGIONAL 

 

  En cuanto a lo que se refiere a la tectónica regional y al origen o génesis de la 

litología, Mendoza (2005) señala una serie de eventos los cuales generan que las 

provincias Imataca y  Pastora, aflorantes al Este del Río Caura, estén en contacto 

discordante y de falla, en el denominado “Frente Tectónico Caura”, con la provincia 

Cuchivero, aflorante al Oeste del Río Caura, que en parte, es la zona de encuentro o 

choques de tres provincias geológicas, con rocas, metamorfismos, tendencias 

estructurales, recursos minerales y edades completamente diferentes y de ambientes 

geotectónicos contrastantes. 

 

 La historia evolutiva del escudo puede sugerirse, según los procesos que se 

han registrado, de la siguiente manera: (Mendoza, 2005) 

 

a) Orogenesis Guriense, > 3.4 Ga, formación de primitivos CRV-TTG. 

 

b) Orogénesis Pre-Transamazónica o Aroensis: 2.96 Ga – 2.85 Ga, 

anfibolitización, granulitización y migmatización de a). Aglutinación, collage, 

de un gran supercontinente que designamos con el nombre de Guayanensis o 

Kenorano (Mason y otros 1995) o Vaalbara (Condie y Sloan, 1998) hacia 2.5 

Ga. 

 

c) Disrupción o rifting del supercontinente Guayanensis hacia 2.4 Ga -2.3 Ga. 

Intrusiones de magmas basálticos, anorogénicos, emplazados del manto 

superior a la corteza Imataca. Estas rocas aún no han sido plenamente 

identificadas. 

 

d) Orogénesis Transamazónica: desarrollo de los océanos Pastora, Barama-

Mazzaruni etc, formándose los CRV de Pastora, Botanamo y equivalentes y 
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rocas graníticas TTG de Supamo, Báltica y equivalentes; subducción, cierre 

de esos océanos; colisión de los CRV-TTG con las rocas granuliticas, 

migmatiticas y anfiboliticas de Imataca-Kanukú, etc: de 2.3 Ga -1.95 Ga, 

definitiva o final granulitización ¿ de a) y b) de rocas de Imataca, formando 

parte del aglutinamiento y formación de otro gran supercontinente 

denominado Atlántica (Rogers, 1996). Rocas TTG de Supamo también 

intrusionaron al Complejo de Imataca en 2.22 Ga en La Esperanza. 

 

e) Al final de la orogénesis Transamazónica o Evento Orocaima: 1.98 Ga-1.88 

Ga, FEV, rocas graníticas intrusivas del noroeste estados Bolívar y 

Amazonas. Evento tectonotermal suave que no afectó casi al Complejo de 

Imataca, aunque intrusiones de granitos más jóvenes de este evento también 

cortaron al Complejo de Imataca. 

 

f) Colisión de Imataca + Pastora (parte del Supercontinente Atlántica) con el 

arco magmático de Cuchivero hacia 1.85-1.80 Ga. Ampliación del 

Supercontinente Atlántica con Cuchivero, Báltica, etc. La zona de sutura se 

denomina Frente Tectónico río Caura. 

 

g) Sedimentación de facies molasoides del Supergrupo Roraima. Inicio de 

fracturamiento del supercontinente Atlántica-Caura y emplazamiento de las 

rocas básicas de la Asociación Avanavero. No se conocen sin embargo 

remanentes de Roraima sobre Imataca, aunque si existen rocas básicas 

intrusivas equivalentes de Avanavero en Imataca. 

 

h) Disrupción y rifting mayor del gran supercontinente Atlántica-Caura hacia 

1.60 Ga-1.35 Ga con el emplazamiento de material del manto a la corteza, su 

mezcla o contaminación con material basal costral granulitico-charnockitico 

del tipo Complejo de Imataca y la diferenciación de ese magma híbrido o 



GONZÁLEZ Y MILLÁN                                                    ANTECEDENTES Y GEOLOGÍA REGIONAL 

 

73 
 

contaminado para dar origen a los granitos rapakivis de El Parguaza, 

Surucucú y equivalentes.  

 

i) Desarrollo de pequeños mares, sedimentación de rocas carbonático-

dolomiticas y algunas sedimentarias samiticas y peliticas clásticas, con pocas 

y escasas volcánicas dacitico-andesiticas intercaladas. Gran parte de esta 

secuencia fue erosionada después de la orogenesis siguiente Nickeriana o 

Grenvilliana. 

 

j) Emplazamiento de algunos complejos máficos-ultramáficos y alcalinos en 

áreas continentales hacia 1.4 Ga-1.3 Ga. Algunas dolomitas, de edad no 

establecida aún, aunque asumida Arqueozoica, aparecen en el tope del 

Complejo de Imataca. Sin embargo las dolomitas de edad Grenville o 

Nickeriana fueron, aparentemente, totalmente (¿) erosionadas en el Escudo de 

Guayana. 

 

k) Orogénesis Nickeriana: cierre de los mares, nueva colisión de placas y 

aglutinamiento de bloques hacia 1.2-1.0 Ga, milonitización y reactivación de 

Fallas como la de Guri, FEV, metamorfismo retrógrado de b) y d). Esta 

orogénesis equivale en tiempo a la Orogénesis Grenville cuya fase final de 

colisiones multiples y aglutinamientos condujo a la formación del 

supercontinente Rodinia (1.0 Ga). 

 

l) Disrupción o rifting del supercontinente Rodinia, reactivación de grandes 

fallas y cruces de fallas, a través de las cuales se emplazaron complejos 

carbonatiticos (Cerro Impacto), làmprofiros (0.85 Ga) y kimberlitas 

eclogiticas (0.71 Ga) de Quebrada Grande, Guaniamo.  

Al final de este evento, mejor desarrollado al sureste de Brasil, Cratón San 

Francisco y África Occidente, conocido como Brasiliano-Pan Africano, se 

formó otro nuevo supercontinente, Gondwana, hacia 0.55Ga,-0.45Ga 
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4.4 ROCAS GRANÍTICAS DEL ESTADO AMAZONAS 

 

En el Estado Amazonas afloran en orden de mayor a menor 

tectonodeformación y metamorfismo, los siguientes conjuntos de rocas: 

 

1) Gneises y Migmatitas tipo Minicia, Macabana, Maroa, etc. 

2) Metasedimentos de medio grado metamórfico del Siapa. 

3) Rocas graníticas y relacionadas, foliadas y levemente metamorfizadas: granitos 

>Volcánicas ácidas > andesitas > basaltos. 

4) Metasedimentos pre-Roraima tipo formaciones Unturán, La Esmeralada, etc. 

5) Granitos anorogénicos, postectónicos tipo Atabapo, Inirida, San Carlos, Cucuy, 

Parima, etc. 

6) Complejos alcalinos y relacionados tales como La Churuata. 

7) Sedimentos grupos pre-Roraima y Roraima. 

8) Carbonatitas de Seis Lagos y equivalentes del lado venezolano y kimberlitas. 

 

Las edades disminuyen del noreste hacia el sur-suroeste y, por el contrario, el 

metamorfismo aumenta en esa dirección. Las rocas volcánicas y plutónicas graníticas 

similares a las de las Volcánicas de Caicara y granitos del tipo Asociación Cuchivero, 

que se ubican en las cuencas de los ríos Asita y Parucito, que tienen poco o nada de 

metamorfismo, presentan una edad de Cuchivero de 1860 - 1730 ma (Gaudette y 

Olsewsky, 1985) mientras que los gneises tonalíticos de Minicia y Macabana entre 

Atabapo y Santa Bárbara, idénticos a los gneises del Complejo de Supamo y Bártica 

solo dieron edades en Rb/Sr de 1.78 a 1.82 Ga (Barrios y otros, 1.985), (FIG.. 4-7). 
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FIG. 4- 6 Edades de rocas graníticas del estado Amazonas (Tomado de Barrios y otros, 1985) 

 

Sin embargo Tassinari y Macambira (1999) incluyen a los gneises de Minicia 

y Macabana en la Provincia Ventuari-Tapajos y reportan una edad U/Pb en circones 

de 1.85 Ga y 1.83 Ga e incluyen incluso a los granitos rapakivis de El Parguaza y 

Surucucú, anorogénicos, con edades U/Pb en circones de 1.54 Ga, en esta Provincia 

Ventuari- Tapajós.  

 

En general el dominio Ventuari presenta rocas graníticas más antiguas que las 

del dominio Casiquiare (Barrios y otros, 1985). Edades del noroeste del Brasil y del 

este de Colombia demuestran buena correspondencia con edades de fuerte 

metamorfismo y magmatismo de la Provincia Casiquiare en el Amazonas 

Venezolano. 

 

Mendoza y otros (1977) agrupan las rocas aflorantes en el estado Amazonas 

en cinco provincias petrotectónicas, estas son: Ayacucho, Manapiare, Alto Orinoco y 

Casiquiare. Las subprovincias Ayacucho y Manapiare equivalen al Dominio Ventuari 

y las del Alto Orinoco, Siapa y Casiquiare equivalen al Dominio Casiquiare (FIG.. 4-

7).  
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FIG. 4- 7  Mapa de Provincias Petrotectónicas del estado Amazonas, a escala 1:1.000.000 (tomado de 

Mendoza y otros, 1977) 
 

Estas provincias serán descritas a continuación: 

 

4.4 DOMINIO VENTUARI  
 

La cual contiene las siguientes subprovincias Petrotectónicas: Ayacucho, 

Manapiare, Alto Orinoco. 

 

4.4.1 SUBPROVINCIA PETROTECTÓNICA AYACUCHO (PPTA) 

 
La Subprovincia Petrotectónica Ayacucho incluye granitos anorogénicos más 

jóvenes y anteriores a 1.550 Ma, tipo Granito Rapakivi del Parguaza, Atabapo (1.696 

ma por Rb/Sr, roca total), Cuao, Granito del Marieta y facies de éstos como la 
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Granodiorita del Sipapo y las Riodacitas Porfídicas del Guayapo (1.340 ± 10 ma), el 

Granito de Guapuchí, etc.  

 

Todos ellos intrusivos en un basamento formado por rocas volcánicas tipo 

Volcánicas de Caicara y granitos biotitícos tipo Santa Rosalía de la Asociación 

Cuchivero.  

 

Las foliaciones del basamento y fracturas de todas las rocas son N10°-30°O, 

estando cortadas por fracturas N30°-50°E. La intersección de estos sistemas de 

lineamientos coinciden con la postulada alta doble anomalía aereomagnéticas y 

radiométricas con posibilidades de localizar depósitos tipo Olympic Dam, en la parte 

sur-central del Granito Rapakivi del Parguaza.  

 

Toda la subprovincia sufrió reactivaciones tectono-termales durante la 

Orogénesis Nickeriana, con milonitización y reajustes de fallas y cruces de fallas, 

emplazamientos de pegmatitas heterogéneas mineralizadas con estaño, columbita-

tantalita y otros recursos minerales, de complejos alcalinos, aplitas y granitos 

especializados ricos en estaño. Los granitos intrusivos son epizonales, mientras que 

los de Cuchivero son mesozonales y las volcánicas son explosivas rioliticas. 

Geomorfológicamente, la subprovincia presenta planaltos, como el de Pijiguaos, 

Chivapure, Cataniapo, etc., que por lixiviación tropical lluviosa dio origen a 

gigantescos depósitos de lateritas alumínicas o lateritas bauxititas. 

 

Discordante encima de toda la secuencia desde los 6° 30’ hasta los 4° de 

latitud norte, aparecen tepuis de rocas del Supergrupo Roraima, diferentes 

estratigráficamente unos con otros (Ghosh, 1977) pero que corresponden a la parte 

superior de Roraima con edad cercana a los 1500 ma., ya que descansan discordantes 

sobre el Granito Rapakivi de El Parguaza, como pudo observarse y muestrearse tal 

contacto en el tepuy del Río Cuao en su curso medio-superior (Mendoza y otros, 

1977). 
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SUBPROVINCIA PETROTECTÓNICA DE MANAPIARE  (PPTM) 

 
Esta subprovincia está compuesta de intrusiones de rocas volcánicas de los 

ríos Asita y Parucito tipo rocas Volcánicas de Caicara y de granitos biotiticos, como 

los de Kakuri y Parú, tipo Granito de Santa Rosalía de la Asociación Cuchivero, en 

un basamento bien expuesto en el Alto Ventuari, en las cercanías de Cerro Impacto y 

otras localizaciones, de gneises y migmatitas tonalitico-trondjemiticas granodioriticas 

(TTG) similares a las del Complejo de Supamo con intrusiones gabroides y 

ultramáficas estratificadas, remanentes de un complejo máfico-ultramáfico 

estratificado con alguna mineralización por sulfuros (pirita, calcopirita y pirrotita) 

como los meta-gabros de Manapiare y de Asita, que representan un objetivo para 

prospectar depósitos de Ni – Cu ± PGEs. 

 

Algunas rocas metasedimentarias pre-Roraima se observan en contacto e 

intercaladas con las rocas volcánicas riolíticas  de Caicara. Las tendencias o trenes en 

las volcánicas siguen fracturas tipo NS como también ocurrió con la Carbonatita de 

Cerro Impacto. Fracturas más antiguas en la zona son de tendencia noreste-noroeste. 

Un cuerpo de forma elipsoidal alargado y orientado aproximadamente norte-sur 

conocido como Carbonatita de Cerro Impacto intrusionó toda la secuencia en tiempos 

post Nickerian y posiblemente post kimberlitas de Guaniamo, más bien relacionados 

con la disrupción de la Pangea y la formación del Atlántico durante el Mesozoico. La 

subprovincia muestra relieve elevado y accidentado, pero menos prominente que el 

de la subprovincia Ayacucho. 

 

4.5 DOMINIO CASIQUIARE 

 
La cual contiene las siguientes subprovincias Petrotectónicas: Alto Orinoco, 

Siapa  y Casiquiare. Descritas a continuación: 
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4.5.1 SUBPROVINCIA PETROTECTÓNICA DEL ALTO ORINOCO 

 

Esta subprovincia se extiende desde la confluencia del Río Ventuari en el Río 

Orinoco hasta las nacientes del gran río y se continúa por Parima y Surucucú en 

Brasil y representa una subprovincia intermedia en composición litológica, 

metamorfismo y tectonismo entre las subprovincias Manapiare y Casiquiare. De allí 

que resulte bastante compleja. Litológicamente está formada por cuarzo-monzonitas 

semimasivas o atectónicas como las de los ríos Parú, Yureba y Marueta, intrusivas en 

gneises tonaliticos y augengneises como los de Macabana, gneises cuarzo-

plagioclásicos-epidótico-biotiticos, granitos trondjemiticos, tonalitas y rocas 

gabroides, es decir del tipo Complejo de Supamo. 

 

4.5.2 SUBPROVINCIA PETROTECTÓNICA DEL SIAPA 

 

Se extiende desde la divisoria de aguas del Alto Orinoco y las de su afluente 

Mavaca con las del río Siapa. Tiene la misma tendencia estructural que la provincia 

Imataca y Kanukú (N 60-70 E) y el trend del Grupo Botanamo, se continúa en Brasil 

(Cachorro) y Guyana. Litológicamente se compone de metasedimentos tectonizados, 

cizallados de esquistos cuarzo-micáceos- estauroliticosgranatíferos y gneises cuarzo-

feldespáticos-epidótico-anfibolíticos y anfibolitas o remantes de CRV, similares a las 

del Grupo Vila Nova de Brasil, de edad Paleoproterozoico pero de trend opuesto en 

90° (Vila Nova de tendencia N 30º-50° W, Siapa de tendencia N 60°-70° E), sobre un 

basamento de gneises tonaliticos y trondjemiticos y migmatitas equivalentes. Toda la 

secuencia infra y supracostral ha sido intrusionada por granitos y granodioritas 

anarogénicas o postectónicas (< 1700 ma). 
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4.5.3 SUBPROVINCIA PETROTECTÓNICA DE CASIQUIARE (PPTCS Y 

PPTC|) 

Es una subprovincia que se caracteriza por su plano y bajo relieve conocida 

como “Penillanura del Casiquiare” y por su complejidad lito-tectonometamórfica. 

  

Las rocas aflorantes entre Atabapo y Santa Cruz cerca de Maroa, Rivas 

(1.985) las denominó Complejo Casiquiare que corresponde en buena parte a lo que 

se cita más abajo como Asociación Atabapo - Maroa. En orden de mayor grado 

metamórfico a menor grado metamórfico se distinguen las siguientes asociaciones:  

 

Asociación Atabapo-Maroa: compuesta por gneises y migmatitas tonaliticos 

y trondjemiticos con intrusiones cuarzo-gabroides a tonaliticas, tipo Complejo de 

Supamo y gneises félsicos y máficos, metamorfizados a la facies anfibolita en cierto 

modo algo parecidos a los gneises de Imataca en la zona de Guri, o los del Complejo 

de El Tinaco en Cojedes, pero que en Amazonas dan edades desde 1630 Ma a 1842 ± 

44 ma. 

 

Asociación Caño Casiquiare: compuestos de complejos gabroides intrusivos 

en rocas graníticas gneisicas tonaliticas, migmatiticas, escasamente trondjemiticas o 

cuarzo mozoniticas con poco o nada de sedimentos asociados, una especie de 

Complejo de Supamo con mayores componentes máficos. 

 

Asociación San Carlos-Cucuy: gneises, augeneises cuarzo feldespático 

anfibólicos con migmatitas y al parecer escasos metasedimentos son intrusionados 

por una serie de granitos anorogénicos pero que no desarrollan una bien definida 

textura rapakivi, como son los granitos de Solano, San Carlos de Río Negro y San 

Simón del Cucuy. Esta asociación forma parte de la Provincia Río Negro-Juruena.  
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Esta subprovincia se caracteriza por la ausencia total de rocas volcánicas y 

plutónicas tipo Asociación Cuchivero, por la escasez de metasedimentos y de 

sedimentos tipo Roraima. Tiene el aspecto de una provincia Pastora, plana y baja, 

donde los equivalentes del Complejo de Supamo han sido más tectonizados y los 

CRV han sido parcial a totalmente erosionados. Al norte del caño San Miguel, que 

sigue una gran falla o zona de cizalla de rumbo cercano a este-oeste, las tendencias 

estructurales en rocas con mayor deformación y metamorfismo son N50°-60°O y N 

10°-30°E. Al sur del mismo caño, las tendencias son más irregulares, destacando las 

norte-sur, este-oeste y N20°-30°E.  
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CAPÍTULO V 

RESULTADOS 

 

 En este capítulo se describen las unidades geomorfológicas observadas en el 

área de estudio, con el fin de diferenciar tipos de relieves, patrón de drenajes, 

litologías, estructuras, suelos y vegetación presentes en el área y la relación que existe 

entre ellos. 

 

 Esto se realiza mediante el uso de los resultados obtenidos en la observación 

visual del mosaico de las imágenes procesadas Landsat 7 ETM + P003R056 y 

P004R056 (FIG.5-1), así como también con a revisión de los mapas:  

 

Hoja topográfica 6733 (Serranía El Espejo) a escala 1:100.000 del IGVSB, 

mapas de suelo y vegetación del municipio Atures, estado Amazonas del MARNR a 

escala 1:2.000.000 y el mapa geológico NB-19-11/19-12 a escala 1:250.000 de CVG 

Tecmin C.A. Todo esto para un mejor entendimiento de la geología de la zona. 
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FIG. 5- 1 Mosaico de las imágenes satelitales P003R056 y P004R056 correspondientes al área de 
estudio (la diferencia de colores en el mosaico se debe a que ambas imágenes fueron tomadas en 

diferentes años y horas).  
 

El área de estudio se caracteriza por presentar 3 unidades geomorfológicas 

contrastantes, fácilmente observables en el resultado de la digitalización de las curvas 

de nivel en el programa ArcGis 9.1, como lo es el modelo digital de elevación 

(DEM), el cual permite tener una mejor perspectiva del área en tres dimensiones, y 

así poder diferenciar el área, discriminándolas en zonas altas y zonas bajas. 

 

En base a este modelo se puede observar que la zona, la cual presenta una 

superficie aproximada de 2016  km2, está dominada en un 65% por zonas altas 

representados por el sistema montañoso (Macizo del Parguaza) ubicado al noreste, 

sureste y suroeste del área, y el 35 % restante por zonas más bajas representados por 

una planicie (sedimentos del Cuaternario) ubicada al noroeste del área hacía los 

márgenes del Río Orinoco. 
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Esta diferencia en la topografía permite definir unidades geomorfológicas, las 

cuales se describen como: Unidad de Mesetas Escalonadas (U1) en tonos rojizos y 

marrones; la Unidad de Planicie con relieves Aislados (U2) de color gris oscuro; y la 

Unidad de Llanura Aluvial del Orinoco (U3) en gris claro, como se muestra en la 

siguiente figura (FIG. 5-2).  

 

 
FIG. 5- 2 Resultado obtenido del  DEM donde se muestran la división de las unidades geomorfológicas 

en la zonas, descritas como: U1 en tonos rojizos y marrones  con alturas que van desde los 1080 m 
hasta los 200 m;  U2 en color gris oscuro con alturas que van desde los 120 m hasta 65 m y la U3 en 

tonos gris claro con alturas que van desde los 65 hasta los 0m. 
 

 

La  Unidad de Mesetas Escalonadas (U1) es la más extensa del área, representa 

el 65 % del área con una superficie aproximada de 1310 km2, constituye el paisaje 

cuya topografía es la más irregular, con alturas que van desde los 1080 m hasta los 

120 m, característica que la convierte en el paisaje dominante del área, observándose 

su mayor expresión al noreste, sureste y suroeste, representado por las Serranías El 

Pavón (con alturas máximas de 440m), Yumene (con alturas máximas de 1000m), De 

Cuenta (con alturas máximas de 1080m), Camarón (con alturas  máximas de 520m)  

y El Espejo (con alturas máximas de 720m). 
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Estas mesetas se encuentran dispersas por toda la unidad en distintos 

desniveles con una orientación preferencial este-noreste, caracterizadas mayormente 

por presentar topes relativamente planos (FIG. 5-3) que descienden a zonas más bajas 

constituidos por escarpes y en menor proporción de topes irregulares (FIG. 5-4).  

 
Presentan laderas asimétricas en la mayoría de los casos y pendientes 

abruptas, dando la apariencia del modelado en forma escalonada, los cuales son el 

resultado de los agentes erosivos que han actuado sobre el macizo.  

 

Parte de esta descripción se puede observar en el perfil topográfico A-A’, 

donde la diferencia de colores representa intervalos de alturas previamente definidos 

en la figura 5-2, para resaltar esta configuración relativamente plana en sus topes, 

como puede observar en la Serranía Yumene (FIG. 5-3). 
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FIG. 5- 3 Vista de la unidad U1 (mesetas escalonadas) donde se puede observar claramente el 
modelado escalonado, presentando topes planos con laderas asimétricas y pendientes abruptas. 
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FIG. 5- 4 Vista de la unidad U1 (mesetas escalonadas) donde se puede observar claramente el 
modelado escalonado en la meseta de la Serranía El Espejo, presentando topes irregulares con  laderas 

asimétricas y pendientes abruptas. 
 

Dentro de esta unidad (U1) se describen dos subunidades representadas por:  
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- Lomas Alargadas (U1a):  

 

Ubicada al suroeste de la unidad con una dirección preferencial noreste, 

caracterizada por presentar laderas asimétricas, pendientes suaves y tope redondeado, 

como se observa en el perfil C - C’. 

 

 

 

FIG. 5- 5 Subunidad de Lomas Alargadas, ubicada al suroeste del área de estudio. 
 
 

- Valles Estrechos (U1b): Estos valles se observan bien drenados, están ubicados en 

los estribos de la Serranía El Espejo suroeste (FIG. 5-6) y hacia el noreste entre las 

Serranías El Espejo norte y Pavón noreste (FIG. 5-7).  
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Suelen presentar relieves residuales en su interior, por lo que se pueden 

describir como correspondientes a niveles de alveolización, ya que los sedimentos 

que forman el suelo del valle son producto de la meteorización y erosión de la roca 

que esta en su interior. 

  

 
FIG. 5- 6 Valles estrechos  correspondientes a los niveles de alveolización. Ubicados al noreste, entre 

las Serranías El Espejo y Pavón. 
 

 
FIG. 5- 7 Valles Estrechos ubicados al suroeste donde se observa los niveles de alveolización. 

 

La red de drenaje presente en la unidad (U1) es muy denso, sus cauces 

principales presentan un patrón rectilíneo y elongados, lo que sugiere un marcado 

control estructural. Ejemplo de ello se observa en los Caños Yumene y De Cuenta, 
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los cuales poseen una extensa longitud,  y presentan la mayoría de sus tributarios con 

tramos cortos y paralelos entre sí, como se puede observar en la siguiente figura (FIG. 

5-8). 

 

 

 
FIG. 5- 8 Imagen con la combinación de bandas R5G4B3 donde se muestra el patrón de drenaje 

rectilíneo en los caños Yumene y Cuenta de la U1. 
 

 

Así mismo se pueden establecer dos divisorias de aguas que coinciden con el 

límite entre los estados Amazonas y Bolívar. La primera de éstas se encuentra hacía 

el sur, separa el drenaje de la Serranía Batata y el Espejo suroeste (estado Amazonas) 

de las Serranías Yumene y De Cuenta (estado Bolívar) marcando claramente la 

división norte – sur. La otra divisoria se encuentra hacia el centro – este del área y 

separa el drenaje de la Serranía El Espejo norte y suroeste (estado Amazonas) y el de 

la Serranía Pavón (estado Bolívar) como se observa en la siguiente figura (FIG. 5-9).  
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FIG. 5- 9 Imagen con la combinación de bandas R5G4B3 donde se muestra las 2 divisorias de aguas  

presente en la unidad U1. 
 

De acuerdo a la configuración que toma el drenaje, se establecen 3 cuencas 

hidrográficas: Al noreste, cuenca hidrográfica del río Parguaza (C1), al noroeste 

corresponde a la cuenca hidrográfica del Orinoco (C2) y al sur, la cuenca hidrográfica 

del río Cataniapo (C3) (FIG. 5-10).  
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FIG. 5- 10 Imagen con la combinación de bandas R5G4B3 donde se muestra las cuencas hidrográficas. 

 

Entre las características más resaltantes del drenaje están los quiebres  

pronunciados en los cauces, los cuales se asemejan a la forma de un codo, señalados 

en la Fig 5-11 con una C, estos indican un marcado control estructural sobre los 

drenajes, además de posible resistencia litológica que impide el paso de los cauces y 

los obliga a cambiar de manera abrupta su trayectoria. 
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FIG. 5- 11 Mapa Topográfico del área mostrando los quiebres pronunciados de los drenajes 

 

 En cuanto a estructuras, en la zona se observa un patrón de fracturas de 

dirección este- noreste  de mayor frecuencia y otro asociado de dirección noroeste-

oeste. Como se puede observar en la Fig 5-12 estos patrones de fracturamiento 

controlan de manera directa el drenaje. 

 

 
FIG. 5- 12 .Mosaico de las imágenes con la combinación de bandas R7G5B4 donde se muestra el 

drenaje controlado por las fracturas.  
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La unidad de Planicie con relieves aislados (U2), abarca el 23 % del área de 

estudio con una superficie aproximada de 464 km2, presenta alturas que van desde los 

120 a 60 m con una pendiente muy baja, está ubicada al noroeste, limitada al sur por 

la unidad de mesetas escalonadas U1 y al norte par la Llanura aluvial del Río 

Orinoco. 

 

A pesar de ser llamada unidad de planicie no se observa del todo uniforme ya 

que presenta relieves aislados con formas dómicas llamados inselbergs, con alturas de 

hasta 240m, y una pendiente de muy bajo grado hacía el noroeste, estos domos se 

observan como remanentes  de la erosión del macizo granítico, donde la roca está 

totalmente desnuda, es decir, sin vegetación aparente. (FIG. 5-13).  

 

 
FIG. 5- 13 En la siguiente imagen de combinación de bandas R4G5B3 se muestra la vegetación en 

tonos naranja y marrones, litología en tonos verdes, los drenajes en azul y el suelo en azul claro.  
 

En esta unidad se encuentra la Cuenca del Río Orinoco el cual sirve como 

colector principal de las desembocaduras de caños  que conforman el área.  
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Dentro de los principales afluentes permanentes que lo integran, se encuentran 

los Caños: Pozo Azul, Agua Linda, Parhueña y Topocho, los cuales presentan cierto 

paralelismo entre sus cauces y su  trayectoria es rectilínea, sin indicios de control 

estructural. Se puede decir que este comportamiento esta mas bien controlado por la 

mineralogía y la composición de los sedimentos que componen  estos suelos.  

 

En general, la mayoría de los caños que se observan en esta unidad tienen sus 

nacientes en la unidad de mesetas. Como lo son los caños Parhueña y Topocho, los 

cuales son los de mayor extensión y presentan un patrón de drenaje semi-rectangular 

en sus nacientes (FIG. 5-14) 

 

 

 
FIG. 5- 14 Imagen con la combinación de bandas  R7G5B4 donde se muestra el paralelismo entre los 

cauces de la unidad U2 y el patrón semi- rectangular en sus nacientes, señalados con círculos 
amarillos. 
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Dentro de esta unidad se pueden distinguir 2 tipos de comportamientos de los 

sedimentos que señalan posibles diferencias en cuanto a la composición litológica o 

mineralógica (geoquímico) que la compone, fácilmente observables por la presencia 

de vegetación hacia macizo y en los márgenes de los caños y ausencia de la misma 

hacía las proximidades del río Orinoco. En la imagen satelital se puede distinguir esta 

diferenciación en zonas en las cuales semejan formas de abanicos aluviales 

accidentados  cortados por el drenaje actual (FIG. 5-15). 

 

 
FIG. 5- 15 Imagen con la combinación de bandas R5G4B3 donde se muestran los abanicos aluviales 

inferidos. 
 

Por último tenemos la Unidad de la Llanura aluvial del Orinoco (U3), la 

cual abarca el 12%  restante del área de estudio, con una superficie aproximada de 

242 km². Este paisaje presenta formas planas sin desniveles, originados por ejes 

fluviales que rellenan algunas lagunas y depresiones poco entalladas.  
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Se caracterizan por la presencia de depósitos limosos, un modelado muy 

aplanado en forma de depresiones marginales a lo largo del Río Orinoco, desarrollado 

sobre aluviones con una vegetación de bosques de galerías donde predominan los 

suelos Entisoles arenosos y los Ultisoles (FIG. 5-16). 

 

 

 
FIG. 5- 16 Imagen donde se muestra la unidad U3 

 

Relación Vegetación – Suelo 
 

Puesto que la zona de estudio está cubierta por vegetación boscosa casi en su 

totalidad (85%) como se observa en la Fig. 6-17, se estimó que la respuesta espectral 

de la cobertura vegetal dependía del tipo de densidad y vigorosidad; estos a su vez, 

guardan una estrecha relación entre las variables ambientales como el relieve, el tipo 

de suelo, y por ende, de las propiedades de las rocas infra yacentes.      
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FIG. 5- 17 Mosaico de las 2 imágenes con la combinación de bandas R6G5B3, el color verde esta 
representado por la vegetación, el azul por los drenajes, el blanco-lila son sedimento aluviales y el 

amarillo la litología (Granito de Parguaza).  
 

El estudio de las condiciones de la vegetación se baso en el uso de los 

resultados obtenidos en las operaciones entre bandas, con el objetivo de resaltar  

características específicas en la imagen, como lo son: El índice de vegetación, para 

identificar la cantidad de material vegetal existente en la superficie; La composición 

mineral, para discriminar los minerales ferrosos, arcillosos y óxidos de hierro 

presentes y así relacionarlos con el tipo de suelo. Así como también, el resultado de la 

clasificación supervisada ya que es una herramienta que agrupa las características 

similares de los distintos tipos de vegetación y suelos.  

 

El índice de vegetación y la clasificación supervisada dieron resultados muy 

similares, ya que en ambas se reflejan dos comportamientos distintos en cuanto a la 

vegetación. 
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 En la primera  se observa casi todo el área cubierta con abundante material 

vegetal (85%), representado en la imagen en tonos blancos; y  otra parte totalmente 

desprovista de ella, representado con tonos oscuros, lo cual puede ser caracterizado 

como sabanas (15%), estos resultados se muestran en la siguiente figura (5-18). 

 

 
FIG. 5- 18 Índice de vegetación de la imagen P003R056, los colores claros representan la cobertura 

vegetal y los tonos oscuros la ausencia de la misma. 
 

 En cuanto al procesamiento realizado con la clasificación supervisada se pudo 

reconocer cinco patrones de firmas espectrales, las cuales se describen como 

respuestas del sensor al agua, sedimentos aluviales, sedimentos coluvio – aluviales, 

roca expuesta y vegetación en el macizo (FIG.. 5-19).  
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FIG. 5- 19 Clasificación supervisada de la imagen P003R056 y P004R056 donde se observa en color 
verde oscuro y verde claro la vegetación, en rojo la roca expuesta, en azul los drenajes y en amarillo 

las zonas ausentes de vegetación vegetación. 
 

 

En cuanto al desarrollo pedogenético observado con respecto a la respuesta 

de la vegetación se tiene que, debido a la litología  (granito de Parguaza) del área se 

han generado perfiles de meteorización, los cuales han originado suelos con un escaso 

desarrollo evolutivo como los son los Entisoles, pudiéndose también encontrar suelos 

con moderado grado de desarrollo evolutivo como los son los Ultisoles y los 

Histosoles, los cuales presentan acumulación de materia orgánica y sirven de sustento 

a una vegetación boscosa con diferentes alturas y densidad de cobertura, donde 

predominan los bosques medios.  

 
 Al hacer una síntesis de todos los resultados obtenidos, se generó el mapa 

geológico, así  como el mapa  hipsométrico producto de la digitalización de las curvas 

de nivel,  que se observan a continuación (FIG.. 5-20 y 5-21) y que pueden ser 

revisados en forma más detallada en el anexo1 y anexo 2. 
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FIG. 5- 20 Mapa geológico generado a través de los resultados obtenidos en el procesamiento de las 

imágenes y la información recopilada del área de estudio. Véase también como anexo 1 
 

 
FIG. 5- 21 Mapa hipsométrico generado a través de la digitalización de las curvas de nivel del mapa 

topográfico (6733) correspondiente a la Serranía el Espejo. Véase también como anexo 2 
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CAPÍTULO VI 

ANÁLISIS DE RESULTADOS 

 

En este capítulo se hace la interpretación de los resultados obtenidos en el 

capitulo anterior con respecto a los mapas de referencia y la bibliografía consultada. 

 

 De acuerdo con las observaciones realizadas a los mapas topográficos, 

geológicos e hipsométricos en conjunto con la revisión bibliográfica existente del 

área, se pueden asociar ciertos rasgos topográficos, descritos por varios autores en el 

país y por otros en países vecinos, que asemejan o corresponden a formas y 

superficies de planación.  

 

 Las unidades geomorfológicas, descritas anteriormente como unidad de 

mesetas escalonadas (U1), unidad de planicie con relieves aislados (U2) y la unidad 

de la llanura aluvial del Orinoco (U3), se corresponden con las descritas por el 

MARNR en el Plan de Ordenamiento del estado Amazonas, aunque con cierta 

diferencia en cuanto al criterio usado para definir el nombre de los paisajes 

observados ya que el POA hace un análisis del estado amazonas en general y en este 

trabajo se presenta de manera más local. 

 

 Estas unidades se diferencian entre sí por presentar características 

morfológicas distintivas en cuanto a alturas, contacto transicional y organización 3D 

relativa. La unidad U1 posee alturas que van desde los 1080 m hasta los 120 m 

observándose una organización en forma de escalones y en contacto abrupto con 

respecto a la unidad U2, la cual presenta alturas máximas de 200m hasta los 65m y se 

encuentra en contacto transicional con la unidad U3 caracterizada por presentar las 

menores alturas que van entre los 65 m hasta el nivel base del río Orinoco. Estas 

formas son originadas por el descenso gradual del macizo. 
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En ésta interpretación, se reconocen al menos cuatro niveles de planación de 

las cinco descritas por McConnell (1968) en Guyana y de las seis descritas por 

Schubert (1990) en Venezuela. Están asociadas a otras superficies a nivel regional 

pero en diferente litología debido a la irregularidad de las rocas del basamento y a la 

disposición de las mismas con los contactos litológicos. 

   

 De acuerdo con Schubert (1990), la formación de superficies de planación en 

el escudo de Guayana probablemente comenzó en el Precámbrico con un sucesivo 

número de superficies que no existen en la actualidad y que fueron originadas por 

varios ciclos erosiónales paleozoicos, en rocas que cubrieron el grupo Roraima las 

cuales fueron completamente removidas. Esto esta soportado por estudios 

mineralógicos hechos por Urbani (1977) los cuales muestran una presencia 

generalizada de muscovita y pirofilita, las cuales fueron interpretadas como evidencia 

para la existencia de al menos varios miles de metros de roca sobre el más alto nivel 

del grupo Roraima (Formación Matauí). Por lo tanto, los procesos que generan estas 

superficies de planación se han considerado policíclicos en el tiempo geológico.  

 

 En cuanto a los niveles de planación descritos por McConnell (1968) en 

Guyana y relacionados por Schubert y Briceño (1990) en Venezuela, se puede 

observar cierta relación con los observados en el área de estudio y se interpretan de la 

siguiente manera: 

 

 La unidad de llanura aluvial del Orinoco (U3) descrita en la zona de estudio 

consiste principalmente en la llanura aluvial del río Orinoco (S3), posee una dirección 

paralela al margen derecho del río, presentando alturas de hasta 65 m. Esta llanura ha 

sido depositada durante el aumento del nivel del mar en el Holoceno (Short y 

Steenken, 1962) 
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Esta unidad (U3) se ubica al noroeste del área y se pueden apreciar, a través 

de las imágenes satelitales, barras de meandros abandonados los cuales forman 

pequeñas lagunas.  

 
Se puede relacionar esta superficie de planación (S1) con la superficie 

planteada por Schubert (1990) descrita como Llanura aluvial del Orinoco, la cual 

ubica en cotas de 0-50 m de edad Holoceno y relacionadas con las superficies 

Mazaruni en Guyana, Quaternary Fluvial Cycle en Surinam y Parguacu en Brasil. 

 

 La unidad de planicie con relieves aislados (U2) que se describe en el área 

(puede ser visto en el mapa hipsométrico, Anexo 2, identificado con el color beige) se 

ubica al noroeste, entre los 65 hasta los 120 m de cota, Schubert y Briceño (1990) la 

ubican entre los 90 y 150 m y coincide con varias superficies de planación, descritas 

en diferentes zonas del escudo y con el tope de la Formación Mesa (Pleistoceno) al 

norte del río Orinoco.  

 

En esta zona los relieves aislados llamados “inselbergs” forman un paisaje de 

rocas con formas de cúpulas dómicas o el distintivo relieve de media naranja, están 

compuestos por el granito del basamento y muestran evidencia de la litología que 

subyace la superficie ya que éstos son productos de erosión diferencial y son 

catalogados como relieves residuales.  

 

 Otra de las características que presenta esta unidad es la presencia de formas 

de abanicos aluviales disectados por el drenaje, que vista a través de las imágenes 

satelitales aparecen con un color claro, posiblemente sean correlacionables con la 

cobertura arenosa del borde del escudo descrita por Khobzi (1980) en el 

Departamento del Vichada, Colombia (ubicada al noroeste), y que se describen como 

“arenas blancas” por su alto contenido de cuarzo originado a partir de un proceso 

pedogenético llamado Podzolización el cual recalca las características del material 

arenoso y cuarzoso y la de un pedoclima muy húmedo. Estas “arenas blancas” se 
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correlacionan con la formación Boa Vista en Brasil, White Sands Series o Berbice 

Formation y North Savannahs Formation en Guyana y Upper Coesewijne Formation 

en Surinam (Schubert, 1990). 

 

 Esta superficie de planación (S2) se relaciona a las superficies Rupununi en 

Guyana, Late Tertiary II en Surinam, Quatrieme Peneplain en la Guyana Francesa y 

Late Velhas en Brasil, con una edad Plio-Pleistoceno (Schubert, 1990).  

  

 En cuanto a la unidad de mesetas escalonadas (U3), parte de ésta se interpreta 

en la zona como la correlación de la superficie descrita por Schubert y Briceño (1990) 

como Caroní-Aro (Oligo-Mioceno?), la cual se encuentra en cotas de 250 a 400 m y 

que fue formada sobre rocas del basamento del Escudo de Guayana. 

 

 Dentro de la superficie Caroní-Aro, se pueden diferenciar dos superficies de 

planación que corresponden a las descritas por Short y Steenken (1962), los cuales 

señalan que existen dos superficies de planación sucesivas a los 400-500 m y a los 

200-350 m de altitud, pero que sugieren que esas pueden ser porciones de la misma 

pendiente (McConnell, 1968).  

 

En esta interpretación, se difiere con estos autores, ya que se puede observar 

que las dos superficies se encuentran bien definidas por separado y que 

geométricamente describen planos muy diferentes en cuanto a su posible formación. 

 

 La primera de estas superficies (S3a), está entre los 200 y 320 m de altura, se 

ubica en las Serranía El Espejo norte, El Espejo suroeste y centro, Serranía el Pavón y 

la Serranía Camarón al noreste.  

 

 La segunda (S3b), se encuentra entre los 320 y 520 m de altura. Se ubica en 

las Serranías El Espejo suroeste-centro y  remanentes aislados de la Serranía Yumene 

noreste. 
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 En estas superficies (S3a y S3b) se pueden encontrar evidencias de la acción 

de policiclos climáticos (descritos por McConnell,1968; Khobzi, 1980) ya que 

presenta zonas de planación y de escarpe a veces con desniveles de unos cientos de 

metros con respecto a la superficie que la precede y además de que en cuanto al 

drenaje, se observaron algunas formas como las gargantas epigénicas donde se rompe 

el equilibrio en cuanto al nivel base, marcando a grandes rasgos la acción de la etapa 

húmeda la cual genera el entallamiento.  

 

 En el mismo orden de ideas, los patrones de fracturas presentes en la zona de 

estudio se evidencian por medio de la adaptación del drenaje al mismo. En esta 

superficie (S3) en particular se observa como el sistema de fracturas contribuyó al 

desarrollo del entallamiento del drenaje y al aislamiento de varias de estas superficies 

entre sí, detalle que no se observa en los niveles superiores o inferiores, por lo que se 

puede llegar a plantear que en esta zona el drenaje aprovecho al máximo la alteración 

química y la debilidad generada por las fracturas para así modelar de manera 

diferencial el paisaje. 

 

 De acuerdo a la altura promedio en que se encuentra, pueden ser relacionadas 

a la superficie Kaieteur descrita por McConnell (1968) en Guyana, Late Tertiary I en 

Surinam, Deuxieme-Troisieme Peneplain en la Guyana Francesa y Oronoque en 

Brasil (Schubert, 1990). 

 

 Otra de las superficies que puede ser observada claramente en nuestra unidad 

de elevaciones con topes amesetados (S4), es la llamada Superficie Imataca, la cual se 

comprende entre los 600 y 700 m. La podemos ubicar al sureste de la zona de estudio 

y comprende gran parte de la Serranía Yumene, que presenta cotas de 560 a 700 m 

. 
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Regionalmente ha sido correlacionada con la superficie Kopinang en Guyana 

(McConnell, 1968), en el Terciario Temprano o “Brownsberg surface” en Surinam, 

“The premier plénéplanation of French Guiana” y la superficie “Sul-Americana” de 

Brasil (Schubert, 1990). Los estudios hechos en Surinam han correlacionado esta 

superficie con la inconformidad entre el Oligo-Mioceno, por lo que Schubert (1990) 

sugiere una edad tentativa de Terciario Temprano a lo que se refiere la superficie 

Imataca. 

 

En cuanto a la influencia de la tectónica es probable que al menos cierta 

cantidad de levantamientos propuestos, que definen la elevación actual de dichas 

superficies, ocurrieran en el Terciario Temprano (Argumento tomado de acuerdo a la 

edad relativa planteada por Schubert (1990) y otros), cuando la superficie de Imataca 

y después la superficie Caroní-Aro fueron formadas.   

 

Así mismo, aunque se conoce que el Escudo de Guayana se está levantando en 

la actualidad a una tasa muy baja, es difícil evaluar la influencia de estos 

levantamientos tectónicos en cuanto a la formación de superficies de planación y sólo 

se relacionan a estas, factores climáticos. Aunque, al menos en el caso de grandes 

diferencias de altura entre las superficies, los levantamientos tectónicos deben haber 

estado involucrados.  

 

Por lo tanto, se puede establecer que, una vez iniciados los procesos de 

generación de superficies de planación, cada una de éstas continuó siendo erosionada 

en climas áridos donde el factor de erosión mecánica fue primordial para la fase de 

aplanamiento y rebajada en climas donde la humedad aumentó y se produjo erosión 

diferencial, entallamiento de los drenajes y los escarpes continuaron retrocediendo 

durante cada evento erosional sucesivo.  En otras palabras, todas las superficies de 

erosión reconocidas en el escudo de Guayana son superficies “actuales” y están 

siendo formadas hoy en día. Evidencia de ello se muestra en la formación de 
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gargantas observadas en la zona donde pareciera que el drenaje avanza hacia el 

macizo. 

La evolución de las superficies de planación ha sido controlada por una 

combinación de factores estructurales, estratigráficos, climáticos, temporales y 

tectónicos en menor grado. 

 

 Al hacer la relación entre las superficies de erosión planteadas y los procesos 

morfogenéticos que han desarrollado su evolución, se puede plantear el siguiente 

esquema o modelo como hipótesis del modelado actual: 

 

 La morfología del Escudo de Guayana ha sido rejuvenecida varias veces por 

periodos de orogénesis y levantamientos, por lo menos cuatro, en el precámbrico: 3.6-

2.7 Ga, 2.6-2.1 Ga, 2.0-1.7 Ga y 1.2-0.8 Ga.  Durante el Fanerozoico fue 

principalmente levantamiento, inclinación e intrusiones de basaltos Paleozoicos y 

diabasas Mesozoicas (Mendoza 1977), las cuales aceleraron el proceso erosional y la 

degradación de superficies de planación previamente formadas. Estos levantamientos 

rebajaron el nivel base regional y causaron una aceleración en la erosión de las 

cabeceras de los arroyos. 

 

 Los sedimentos del Grupo Roraima fueron depositados en cuencas sinclinales. 

Los bajos, áreas erosionadas alrededor de ellas, corresponden a anticlinales 

desmantelados, lo que se denomina: inversión de relieve, por lo que podemos 

encontrar en la actualidad remanentes de Roraima en otras zonas, a la misma altura 

que el basamento en la zona de estudio. 

 

 El clima ejerce el control más importante del modelado. Un clima árido 

erosiona por acción mecánica además de eliminar la vegetación existente. Por otro 

lado, la abundante precipitación en un clima húmedo contribuye no solo a la 

degradación química de la roca sino también a la remoción de material clástico que es 

fácilmente transportado por la escorrentía.  
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El sistema de fracturas generalizado (principalmente fracturas en la zona pero 

también posibles fallas a nivel regional) constituye un efecto determinante en el 

proceso erosional de las superficies en estrecha relación con el drenaje. 

 

Tomando información obtenida de acuerdo a otros autores (Millot, Bocquier, 

y otros, 1976) y a estudios similares hechos en otras regiones con las mismas 

características de litología y clima, se puede decir que la evolución geoquímica de los 

paisajes se presenta en cinco etapas, las cuales se describen a continuación: 

 

Primera etapa: El paisaje para esta época se encontraba protegido por una 

coraza ferruginosa más compacta en la parte más baja en un clima tropical húmedo. 

 

Segunda etapa: Es un clima relativamente más seco con precipitaciones 

inferiores a los 1000 mm anuales, se produce lixiviación en la parte superior (donde 

el agua es suministrada por el escurrimiento de los inselbergs) y la arcilla que se 

forma es la caolinita, mientras que en la parte inferior hay acumulación y la arcilla 

que se forma es la mortmorillonita, la cual asciende hacia la parte superior producto 

de la migración de material hacia la parte inferior.  

 

En la  zona de empalme se produce la meteorización química que socaba el 

pie de los “inselbers”, endereza las vertientes, produce los glacis y provoca un 

modelado geoquímico del paisaje por redistribución de materia al interior de las 

formaciones superficiales.  

 

Tercera etapa: De nuevo el clima se hace más húmedo y se origina un 

modelado más o menos ondulado originado, en parte, a la infiltración de agua en 

zonas vulnerables a la meteorización física y por otra parte, a la destrucción de la 

coraza ferruginosa y al arrastre de los bordes del material cada vez mas fragmentado. 

 



GONZÁLEZ Y MILLÁN                                                                             ANÁLISIS DE  RESULTADOS 

 

110 
 

Cuarta etapa: Se produce durante un período muy seco, el cual originó 

paisajes áridos como los médanos de Apure (Llanos). Debido a este clima desértico, 

se desaparece casi por completo la vegetación, el suelo queda expuesto a la erosión 

eólica y a medida que desaparece la vegetación los inselbergs pierden los suelos 

delgados que lo cubrían. En los glacis removidos los suelos se adelgazan. El paisaje 

general es el de grandes campos desérticos con inselbergs aislados. 

 

Quinta etapa: El modelado se desarrolla en un clima más húmedo (clima 

actual del estado Amazonas). Se produce el hundimiento o “entallamiento” de la red 

hidrográfica, el paisaje toma el aspecto de una peniplanicie ondulada con un relieve 

en media naranja. 

 

El paisaje que se observa actualmente es el resultado de la influencia de esos 

mecanismos que han actuado durante millones de años. 

 

 Así mismo, se puede inferir un modelo evolutivo de la geomorfología actual 

de la zona en base al modelo geoquímico, el cual se puede interpretar de la siguiente 

manera: 

 

 En la primera etapa (FIG. 6-1) se presenta un ambiente húmedo en el granito 

expuesto el cual genera erosión química de la roca. 

 

 
Fig 6-1. Primera etapa 
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En la segunda etapa (FIG. 6-2), en un clima más árido y seco, se produce la 

erosión mecánica de la superficie, extinción de la capa vegetal que cubre los suelos 

dejándolos propensos a la acción de la meteorización y erosión, generando superficies 

planas y retrocesos de escarpes. 

 

 
Fig 6-2. Segunda etapa etapa. 

 

 En la tercera etapa (FIG. 6-3), la humedad es el factor determinante para el 

entallamiento de los drenajes, formación de relieves irregulares debido a la erosión 

diferencial y química y generación de nueva cobertura vegetal. 

 

 
Fig 6-3.Segunda etapa 
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En la cuarta etapa (FIG.6-4), en un clima árido, se produce la erosión 

mecánica de la roca expuesta, extinción de vegetación que cubre los suelos. Este 

clima se puede relacionar al periodo glaciar reciente que tuvo lugar hace más de 

10.000 años. 

 

 
Fig 6-4. Tercera etapa 

 

 

En la quinta etapa (FIG. 6-5), clima húmedo actual, se modela el paisaje a 

como se ve representado hoy en día. Se produce el entallamiento del drenaje y 

erosión química que moldea la fisionomía de las cumbres y los escarpes 

constituyendo las formas que hoy en día se pueden observar, además de generar 

nueva vegetación. 

 

 
Fig 6-5. Quinta etapa 
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En cuanto a los resultados obtenidos con respecto a la elaboración del mapa 

geológico, se pudo notar que, con respecto a los mapas de referencia se hace una 

mejor aproximación de los posibles contactos entre el macizo y el sedimento 

cuaternario además de afinar los rasgos estructurales, ya que se logro trabajar a una 

menor escala con mayor nivel de detalle. 

 

Esto se puede observar entre los mapas geológico – estructural realizado por 

C.V.G. Técnica Minera (s/f) el cual fue realizado a una escala 1:250.000 y el mapa 

resultado de este trabajo que se realizo a escala 1:100.000 (Ver mapa geológico 

anexo). 

 

Así mismo, se observan en algunos casos diferencias y similitudes en cuanto a 

los alineamientos estructurales descritos por los mapas base y los observados en los 

resultados, y en cuanto al contorno que definen varios tipos de sedimentos 

cuaternarios. Un ejemplo de ello es como los sedimentos aluviales y los coluvio-

aluviales se diferencian entre sí de manera notoria en la imagen satelital. 

 

En este mismo orden de ideas, podemos señalar que, haciendo los diferentes 

procesamientos de las imágenes satelitales, se obtuvieron cuatro patrones de firmas 

espectrales que representan el agua y los recursos hídricos, la vegetación, la posible 

roca a la intemperie y un tipo de suelo que sólo se presenta al noroeste en la margen 

derecha del río Orinoco. 

 

Se puede apreciar de manera significativa que la vegetación se encuentra 

distribuida de manera bien marcada en el macizo donde se encuentra el granito y 

hacia los cauces de los caños que atraviesan la planicie aluvial con relieves aislados.  

Por lo tanto, se puede interpretar que los suelos que se generan en la unidad de 

planicie deben presentar la misma composición mineralógica que los suelos 
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generados en el macizo (esto se contradice con TECMIN, ellos reportan diferentes 

tipos de suelos).  

 

En el caso de los depósitos de sedimentos de tipo abanico aluvial disectado, se 

puede interpretar como un tipo de sedimento con otra composición mineralógica. 

Haciendo un enfoque más amplio de este tipo de formas y observando a nivel 

regional este tipo de sedimentos en particular, se pudo observar que éstos sólo se 

encuentran en una fracción menor hacia la margen derecha del río Orinoco y en 

mayor extensión hacia la margen izquierda del mismo, en el territorio colombiano. 

Por lo tanto, se puede inferir que estos sedimentos podrían tener su origen en la 

cordillera colombiana y depositados en estas zonas del país por un agente de 

transporte como el río Orinoco en un sistema de paleodrenaje, lo que daría 

explicación a este sedimento irregular en la zona. Es decir, que no son abanicos 

aluviales sino sedimentos aloctonos que presentan esa morfología. 

 

En los resultados, se pudo observar que este tipo de suelo en particular, 

después de usar el procesamiento que define la composición mineral, resulto como 

una zona con alto contenido de óxidos de hierro. En la literatura lo clasifican como 

producto de podzolización, lo que se relaciona con un pedoclima muy húmedo. Así 

mismo, si se toma en cuenta el pedoclima húmedo con un alto contenido de oxido de 

hierro se puede estar en presencia de un posible ambiente el cual genera esta 

mineralización. 

 

Teniendo en cuenta que los sensores remotos, en específicos las imágenes del 

sensor Landsat 7 ETM+, obtienen la respuesta de la vegetación, se puede decir que 

con respecto a ésta el sensor refleja cinco patrones de firmas espectrales. 

 

Estos patrones de firmas espectrales al haber sido comparados con las 

unidades geomorfológicas descritas da una relación estrecha entre el tipo de 

vegetación y por ende el posible tipo suelo que la subyace. Por ejemplo, en el macizo 
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se dan dos tipos de respuestas ante la vegetación y se interpretan como zonas en 

donde existe un tipo de vegetación que se clasifica como bosques y en otras zonas 

donde se presenta la roca expuesta.  

 

En la planicie y la llanura aluvial se obtuvo al igual varios tipos de respuestas 

del sensor, una para la vegetación presente a lo largo de los cauces de los ríos que 

desembocan al Orinoco clasificada como bosque, una para la zona que presenta un 

tipo de sedimento diferente donde pareciera carecer de vegetación que es definido 

como sabana y las zonas de la llanura aluvial y la intersección del macizo con la 

planicie en las cuales se presenta otro tipo de bosque. 

 

Al analizar la imagen resultante para el índice de vegetación y la clasificación 

supervisada se observó que las zonas donde se realzo la concentración de vegetación 

boscosa y donde se observo la ausencia de la misma, coinciden en gran medida con 

los datos reportados por el MARNR (2003) correspondiente al desarrollo de las 

formaciones vegetales de bosques y de sabanas. 
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CAPITULO VII 

 
7. CONCLUSIONES Y RECOMENDACIONES 

7.1 CONCLUSIONES 

 
El paisaje que se observa actualmente es el resultado de la influencia de los 

mecanismos de erosión que han actuado durante millones de años. 

 

El control climático es el más importante para la formación de superficies de 

planación y para el modelado de la superficie, debido a que actúa en un rango de 

tiempo menor que los procesos tectónicos que rigen el escudo. 

 

El drenaje y las fracturas son los principales factores que influyen en el 

modelado del relieve y están directamente relacionados. El drenaje actúa en las 

fracturas por las zonas de debilidad generadas. Esto se complementa con la erosión 

química y diferencial, la cual aprovecha para alterar y modelar el relieve de la zona. 

 

Debido a la escala en la cual se realizo el mapa geológico-estructural de CVG-

Técnica Minera, se pudo observar que muchos detalles fueron omitidos y que, aunque 

sirvió de guía para la elaboración de este trabajo, presenta algunas diferencias. Con 

este trabajo se pudo mejorar la información geológica de la zona en cuanto a un mejor 

nivel de detalle. 

 

La evolución de las superficies de planación ha sido controlada por una 

combinación de factores estructurales, estratigráficos, climáticos, temporales y 

tectónicos en menor grado. 

 

 A través de la realización del Modelo Digital de Elevación (DEM) fue más 

fácil realizar la discriminación de los rasgos topográficos presentes en la zona de 

estudio ya que esta herramienta permitió realzar las características topográficas en 

tres dimensiones y obtener una geometría relativa de las estructuras. 
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 En cuanto a la comparación de los resultados obtenidos con los mapas bases y 

la información bibliográfica recopilada se pudo observar que la cartografía realizada 

correspondió en gran parte con lo descrito por los diferentes autores, lo que nos lleva 

a concluir que la herramienta utilizada es confiable para ser usada en estudios 

geológicos de zonas de difícil acceso y como información previa a posibles trabajo de 

campo. 
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7.2 RECOMENDACIONES 

 
 
 
 

Adquirir imágenes que sean tomadas en el mismo año y horas, para minimizar 

los efectos producidos por los factores de incidencia en la respuesta espectral, tal 

como la altura solar. 

 

Usar imágenes satelitales multiespectrales como las ASTER, las HYPERION 

y las SPOT  ya que estás al poseer mayor cantidad de bandas y una mejor resolución  

permitirá obtener resultados más precisos.  

 

La recopilación cartográfica para generar un mapa geológico a través de 

sensores remotos debe estar a la misma escala o a menor escala, para que el resultado 

sea un mapa con mayor detalle. 

 

Generar mapas por técnicas de sensores remotos en zonas de difícil acceso, así 

como también en zonas accesibles, pero este último debe ir acompañado de salidas de 

campo para corroborar los resultados obtenidos. 
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APENDICE  

 

METODOLOGÍA DEL PROCESAMIENTO DE LAS IMÁGENES 

 

El procesamiento de imágenes está relacionado con la corrección y calibración 

de las imágenes, con el fin de conseguir una representación lo más fiel posible de la 

superficie de la tierra. Una variedad de turbaciones sistemáticas pueden combinarse 

para degradar la calidad de la imagen recibida finalmente. La restauración o 

corrección de la imagen trata de remover esos efectos de degradación. (Alzate, 2005) 

 

La restauración de las imágenes se realiza con las Correcciones 

Radiométricas, las cuales se refieren a la remoción o disminución en el grado de 

energía electromagnética registrada por cada detector.  

 

Correcciones Radiométricas 
 
Teniéndose el conjunto de imágenes en formato TIFF y la metadatas, se realizan los 

siguientes pasos: 

 

A.1. CALIBRACIÓN DE LA RADIANCIA 

 
 Los valores de los pixeles en imágenes satelitales representan la radiancia de 

la superficie en forma de números digitales (ND), los cuales al ser calibrados para 

ajustarlos en un cierto rango de valores. La calibración de estos valores para la 

imagen LANDSAT7 ETM, se realiza mediante el uso de paquete informático ENVI 

® 4.2. Los pasos a seguir son los siguientes:  

 

1. En la barra del menú principal  selecciona la opción Basic Tools → 

Preprocesing → Calibration Utilities → Landsat TM (FIG. A.1), aparece 
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una ventana de título “TM Calibration Input File” se pulsa sobre el botón 

Open →  New File (FIG. A-1). En la ventana “ Please Select  a File ” se 

busca y selecciona uno de los archivos TIFF, pertenecientes a una de las 

bandas (FIG. A- 1). Este paso se repite tantas veces como imágenes TIFF se 

tengan. 

 

 
FIG. A- 1 22Menú principal de ENVI,  ventana “TM Calibration Input File” y selección del archivo en 

formato TIFF. En el software  ENVI ® 4.2 
 

2. Seguidamente aparece la ventana “TM Calibration Parameters” (FIG. 

A- 2), donde se introducen los datos asociados a la imagen tales como fecha 

de adquisición, elevación del sol, valores máximos y mínimos de radiancia 

(estos valores son propios de cada imagen). 

 

Luego de introducir estos datos se debe hacer clic en el botón Choose para 

determinar la ruta  y el nombre del archivo de salida. Este procedimiento se debe 

repetir  con cada uno de los archivos de bandas. Estos datos y valores asociados a la 

imagen, se encuentran en el archivo de “metadata” adjunto a la imagen Landsat 7 

(FIG. A-2). 
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FIG. A- 2 Ventana de Parámetro de Calibración y archivo “metadata”. En el software  ENVI ® 4.2 

 

3. Para observar el resultado de  la corrección de radiancia para cada 

banda se selecciona en la barra del menú principal en el menú ENVI ® 4.2  la 

opción File → Open Image File, aparece la ventana Enter Data Filenames 

donde se busca y selecciona el archivo generado para cada banda. (FIG. A-3).  

 

 
FIG. A- 3 Pasos a seguir para abrir los archivos generados en la corrección de Radiancia. En el 

software  ENVI ® 4.2 
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4. Como resultado se obtiene la calibración de radiancia para cada una de 

las bandas (FIG A-4). 

 

 
FIG. A- 4 Calibración de Radiancia. Bandas 1,2,3,4,5,7 ( de izquierda a derecha). Imagen P003R056. 

En el software  ENVI ® 4.2 
 

A.1.2 FUSIÓN DE BANDAS 

 
Una vez obtenidas todas las imágenes con radiancia corregida, se procede a 

unirlas  en una sola imagen, mediante la función Layer Stacking del ENVI® 4.2. Se 

deben colocar las bandas en orden creciente, ya que es importante seguir la secuencia 

original de las bandas. 

 

1. En a barra del menú principal, se selecciona Basic Tools → Layer 

Stacking (FIG. A-5). Ahí se despliega una ventana titulada Layer Stacking 

Parameters (FIG. A-5), luego se da un clic en “choose” para determinar la ubicación 

y el nombre del archivo de salida y luego “OK”, luego se despliega otra ventana 

titulada Layer Stacking Input File, en la cual se van a seleccionar como entrada los 

seis archivos de radiance corregidos en el paso anterior (FIG. A-5).  
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FIG. A- 5 Selección del Layer Stacking, y ventanas de entrada  y de salida de la unión de las bandas. 

En el software  ENVI ® 4.2 
 

2. Como resultado se tiene la fusión de todas las bandas 1,2,3,4,5 y 7 (FIG. A-6).   

 

 

              (a)                                     (b)                                         (c) 

FIG. A- 6 Fusión de bandas de la  Imagen P003R056E  . Combinación : (a) R7G5B1. ; (b) R4G3B2 
Falso color infrarrojo. ; (c) R5G4B3.  Falso color. En el software  ENVI ® 4.2 

 

 

A.1.3 CONVERSIÓN A FORMATO BIL 

 
Los  archivo de salida resultante del Layer Stacking se encuentran en formato 

BSQ (formato secuencial de bandas), es necesario llevarlo al  formato BIL (formato 

de bandas intercalados por línea) ya que es el utilizado por la mayoría de las 

aplicaciones de procesamiento del ENVI® 4.2. 
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1.  Para cambiar el formato  se debe hacer clic en Basic Tools → Convert 

Data BSQ, BIL, BIP” (FIG. A-7), se despliega la  ventana Convert File Input File, 

donde se selecciona el archivo generado en la fusión  de las bandas realizada en el 

paso anterior, luego se hace clic en OK, aparece la ventana Convert File Parameters 

donde se selecciona la casilla Output Interleave BIL→ Choose donde  se selecciona  

la ruta y el archivo de   salida y luego se hace click en Ok (ver figura A-7)     

 

 
FIG. A- 7 Selección de cambio de formato en el menú de ENVI,   selección de la fusión de bandas y 

del formato del archivo de salida BIL. En el software  ENVI ® 4.2 
 

2. Al finalizar el procedimiento, queda una imagen en formato BIL (FIG A-8) 

que significa bandas intercaladas por líneas, formato que sirve para obtener imágenes 

corregidas geométricamente de gran utilidad para la cartografía de la zona, después 

de la utilización de técnicas de tratamiento digital. 
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FIG. A- 8 Obtención de la imagen en formato BIL, combinación de bandas R1G3B5. Imagen 

P003R056. En el software  ENVI ® 4.2 
 

A.2 CORRECCIÓN DE EFECTOS ATMOSFÉRICA (FLAASH) 

 
Seguidamente se debe realizar la corrección de efectos atmosféricos  

FLAASH (Fast Line of- sight Atmospheric Análisis of Spectral Hypercubes). 

Mediante esta aplicación se elimina de la radiancia recibida por el sensor los efectos 

de absorción y dispersión de la energía electromagnética, causados por las moléculas 

y partículas atmosféricas en suspensión.  Consiste en aplicar un factor de 10 a las 

bandas debido a que la radiance en imágenes LANDSAT viene dada en W/m² um sr, 

y FLAASH requiere las unidades en W/cm² um sr. 

 

Para la aplicación de esta función se requiere de parámetros de entrada, 

contenidos en la metadata. Se procede de la siguiente manera: 

 

1. Se crea un archivo .TXT (Bock de notas), donde se introducen los valores 

de frecuencia de onda ordenados en una columna Los valores correspondientes son 

los siguientes: 0.484, 0.56, 0.66, 0.83, 1.65, 2.215, los cuales representan valores 

promedio entre el máximo y mínimo valor de longitud de onda para cada banda. 
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2. Para realizar la corrección FLAASH se debe hacer clic en Basic Tools en el 

menú principal de ENVI® 4.2 , se selecciona Preprocesing → Calibration Utilities 

→ FLAASH” (FIG. A-9), se despliega una ventana titulada FLAASH atmospheric 

correction model input parameters, se hace clic sobre el botón input radiance image 

que abre la ventana FLAASH input file donde se selecciona el archivo BIL generado 

en el paso anterior, luego se presiona OK (FIG. A-9). 

 

 
FIG. A- 9 Corrección FLAASH en el menu principal del ENVI, selección del archivo BIL y ventana 

FLAASH atmospheric correction model Input parameters. En el software  ENVI ® 4.2 
 
 

3. Al mostrarse la ventana de título  Enter ASCII Filename Containing 

Wavelengts and  fwhm se selecciona el archivo .TXT que contiene los valores de 

frecuencia de onda creadas en el paso 1, seguidamente se muestra la ventana Input 

ASCII File  donde aparecen estos valores (FIG.A-10) y se presiona “OK”. Luego se 

abre la ventana radiance scale factors en la cual se debe seleccionar use sigle scale 

factor for all bands se coloca“10”en single scale factor y se presionaOK. (FIG. A-

10). 
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FIG. A- 10 Ventanas:  Enter ASCII Filename Containing Wavelengts and  fwh;  Input ASCII File y  

Radiance Scale Factors. En el software  ENVI ® 4.2 
 

4. Luego en la  ventana  FLAASH atmospheric corretion model input 

parameters (FIG. A-11), seleccionar el botón Output Reflectance File, se colocan la 

ubicación y el nombre del nuevo archivo de salida. Después se selecciona el botón 

Output Directory for FLAASH File, y se coloca la carpeta que va a contener el 

archivo de salida.  

 

En la opción Sensor Type → UNKNOWN-MSI → Multiespectral → 

Landsat TM7 (FIG. A-11). Luego se hace clic en el botón Multiespectral settings y 

se despliega la ventana Multiespectral settings donde se seleccionan las bandas 7 y 3 

de la imagen LANDSAT en KT Upper Channel y en KT Lower Channel 

respectivamente, se presiona “OK” (FIG. A-11). 
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FIG. A- 11 Ventanas :FLAASH atmospheric corretion model input parameters y Multiespectral 

settings. En el software  ENVI ® 4.2 
 

5. Una vez introducidos los parámetros se pulsa el botón Apply en la ventana 

FLAASH atmospheric corretion model input parameters (FIG. 5-10), la cual muestra 

una ventana en progreso, dando como resultado la imagen con la corrección 

Atmosférica (FLAASH)(FIG. A-12). 
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FIG. A- 12 Resultado de la corrección atmosférica FLAASH y visualización de la imagen corregida 

con la  combinación de bandas R3G4B5. Imagen P003R056. En el software  ENVI ® 4.2 
 

A.3 CORRECCIÓN DE LA  FRACCIÓN MINIMA DE RUIDO (MNF) 

 
 La corrección de Fracción Mínima de Ruido permite la disminución del ruido 

en la data espectral. Para realizarla se realizarla se procede de la siguiente manera: 

 

A.3.1 CONVERSIÓN DE TIFF A IMG: 

 
 Para esto se requiere una imagen de extensión IMG. Este archivo es el 

resultado de la fusión de las imágenes de extensión TIFF. Para generar este archivo se 

utiliza el Software ERDAS IMAGINE® 8.5 y se procede a hacer lo siguiente: 

 

1. En la barra del menú principal se presiona Import, en la ventana de titulo 

Import /Export se selecciona en la opción Type →TIFF y en Media → File . En la 

opción Imput File se elige el archivo TIFF perteneciente a la primera banda, se 
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coloca la ruta y el archivo de salida IMG y luego se presiona Ok. Este paso se repite 

para cada una de las imágenes TIFF. 

 

2. Seguidamente se hace la unión de Imágenes IMG. En la barra del menú se 

presiona Interpreter → Utilities → Layer Snack . En la opción Imput File se 

selecciona  cada archivo IMG creado en el paso anterior .En la opción Layer se elije 

la opción 1 y para el resto de las imágenes se selecciona del cuadro de lista la opción 

All.  

 

Esto se repite para cada archivo IMG y su correspondiente Layer 

seleccionado, luego se presiona el botón de acción Add. En la opción Output File se 

coloca la ruta y el archivo de salida correspondiente a la fusión IMG y luego se 

presiona Ok . 

 

A.3.2 CREACIÓN DEL ARCHIVO SHAPEFILE EN ARCGIS® 9.1.   

 

Previo a la corrección, es necesario extraer de la imagen los pixeles 

correspondientes a las nubes y sus sombras, ya que representan valores extremos en 

la imagen. Los cuales pueden ser confundidos con rasgos topográficos en el software 

ENV!®  4.2. Para esto se genera un archivo “Shapefile” de nombre Mascara de 

Nubes en el software ArcGis® 9.1 de la siguiente manera: 

 

1. Se abre el archivo de extensión IMG que contiene la fusión de imágenes. Al 

realizar esta acción, aparece la venta adicional y en el menú desplegable seleccionar 

la opción New→ Shapefile , seguidamente se abre la ventana Create New Shapefile 

donde se coloca en las opciones  Name →  Mascara de Nubes y en Feature Type 

→  Poligon  → Ok (FIG. A-13). 
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FIG. A- 13 Ventana principal de ArcGis que muestra la creación del Shapefile de la máscara de nube. 

En el software arcgis® 9.1 
 

2. Aparece la ventana Propiedades de Spatial Referente donde se pulsa Select,  

luego en la ventana Browse for Coordinate System se hace clic sobre el botón edit…, 

y se despliega la ventana Propiedades de Spatial Reference, se hace clic sobre el 

botón import… (FIG. A-14). 

 

 
FIG. A- 14 Selección de las Coordenadas UTM en la ventana Propiedades de Spatial Referente. 
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Generalmente para la imagen utilizada en este trabajo se selecciona como 

referencia WGS 1984 UTM ZONA 19 N (FIG. A-15), y finalmente se hace clic en 

aceptar → OK. Se ha creado el shapefile de nombre “Mascara de nubes” ahora se 

procede a encerrar en polígonos las nubes y sus sombras. 

 

3. Para la creación de estos polígonos se pulsa en el menú principal la opción 

Editor → Start Editing. Se empieza a delimitar el borde de las nubes y sus sombras, 

creando polígonos cerrados (FIG. A-15).  

 

 
FIG. A- 15 Creación del Shapefile para la  Máscara de nubes. Imagen P003R056. En el software 

arcgis® 9.1 
 

4. El archivo generado anteriormente se importa al software ENVI® 4.2 para 

transformarlo a un archivo con extensión ROI. En el menú principal de ENVI® 4.2  

seleccionar File → Open Vector File, en la ventana de Select Vector Filenames  se 

debe abrir el archivo de  máscara nubes  realizada en ArcGis 9.1, luego se despliega 

la ventana Import Vector File Parameters  se hace clic en Choose, para determinar el 

software ENVI® 4.2 nombre y ubicación del archivo de salida y luego se pulsa OK 

(FIG.  A-16).  
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FIG. A- 16 Selección de  nombre y ubicación del archivo de salida en la Ventana Import Vector Files  

Parameters  del software ENVI® 4.2 
 

Posteriormente se abren dos  nuevas ventanas llamada Available Vector List y 

Load Vector,  en la cual se escoge el archivo que se importó anteriormente y se hace 

clic en OK de  Load Selected. Se abre la  ventana #1 Vector Parameters donde se 

selecciona File → Export Active Layer to ROIs, aparece la ventana Export EVF 

Layers to ROI. En ella se selecciona la opción Convert all records of fan EVF layer 

to one ROI → OK.  

 

5. Seguidamente en el menú principal se presiona Basic tools → Masking → 

Build mask, se abre la ventana  Mask Definition, se selecciona Display # 1→ Ok.. 

Se despliega la ventana #1 Mask Definition, se pulsa el comando Options → Import 

ROIs, en la ventana Mask Definition Input ROIsse se verifica que aparezca 

seleccionado el archivo recién importado y se presiona OK. En la ventana #1 Mask 

Definition pulsar el comando Options → Select Areas “Off” y se selecciona choose 

donde se le da un nombre al archivo de salida y se hace clic sobre Apply. 
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Una vez realizados todos estos pasos, se procede a realizar la corrección de la 

fracción mínima de ruido (MNF). 

 

A.3.3 CORRECCIÓN  DE LA FRACCIÓN  MÍNIMA DE RUIDO (MNF) 

1. El menú principal de ENVI 4.2 Se presiona  el comando  Spectral → MNF 

Rotation →Forward MNF → Estimate Noise Statisttics from data (FIG. A-17).  

 

 

 
FIG. A- 17 Transformación de la Fracción Mínima de Ruido (MNF), menú principal ENVI. 

 

2. Se abre la ventana MNF Transform Imput File, se escoge el archivo de 

salida de la corrección atmosférica (FIG. A-18), luego aparece la ventana Select 

Spatial Subset  donde se pulsa la opción Image. A continuación aparece la ventana 

Subset By Image, donde se  delimita el área donde se va a realizar la Corrección MNF 

(FIG. A-18), luego se hace clic sobre OK → Spectral Subset. 
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 Se despliega una ventana llamada File Spectral Subset  se seleccionan las tres 

primeras bandas y luego se pulsa Ok. Aparece la ventana de título  Foward MNF 

Transform Paramaters, en la cual se escogen la ruta y el nombre del archivo de salida 

en Output Noise Stats Filename y en Enter Output Filename, y para finalizar se 

selecciona Ok (FIG. A-19). 

 
FIG. A- 18 Selección del área de estudio. Imagen P003R056. En el software  ENVI ® 4.2 

 

 
FIG. A- 19 Selección del archivo de la ruta y archivo de salida. En el software  ENVI ® 4.2 

 

3. Finalizando el proceso aparecerá una ventana de título MNF Eigenvalues, 

que muestra un grafico de los autovalores MNF organizados en orden decreciente de 

la varianza (FIG. A-20 y A-21). 
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FIG. A- 20  Grafico de los autovalores MNF organizados en orden decreciente de la varianza, en el 

software  ENVI ® 4.2 
 

 

 
FIG. A- 21 Vista de la  Imagen Landsat 7 P003R056I  con la combinación de bandas MNF (1,2,3. En 

el software  ENVI ® 4.2 
 



GONZÁLEZ Y MILLÁN                                                     APENDICE 

 

142 
 

A.3.4 ÍNDICE DE PUREZA DE PÍXEL (PPI) 

 
  El Índice de Pureza del Píxel (PPI) se realiza en el software ENVI® 4.2. En 

éste procedimiento se selecciona los píxeles extremos en la data  que satisfacen el 

número de iteraciones o el factor de tolerancia propuesto por el usuario, lo que 

aumenta el nivel de pureza de la imagen. El procedimiento es el siguiente: 

 

1. En la barra del menú principal de ENVI® 4.2, se selecciona el comando 

Spectral → Pixel Purity Index → [FAST] New Output Bands. Se abre la ventana 

Fast Pixel Purity Index Input Data File , en la cual se selecciona el archivo MNF 

creado en el paso anterior y se presiona Spectral Subset para escoger las 3 primeras 

bandas (estas son las que poseen la mayor información de la data) y se hace clic en 

Ok (FIG. A-22). 

 

 
FIG. A- 22 Ventana Fast pixel Purity Index Input Data File  y File Spectral Subset. Para el PPI. En el 

software  ENVI ® 4.2 
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En el procedimiento se muestra un gráfico en el cual se observa el estado del 

proceso, donde se muestra el total de números de píxeles extremos que satisfacen el 

criterio de tolerancia del PPI como una función del número de iteraciones. 

 

Posteriormente se abre la imagen resultante del proceso anterior, donde se 

selecciona la opcion Overlay → Density Slice, se abre una ventana llamada Density 

Slice Bands Choice, se selecciona el archivo al que se le aplicó PPI y se le hace clic 

en OK. Seguidamente se visualizan los pixeles extremos encontrados por el PPI en el 

espacio de mezcla espectral, de forma manual se seleccionan aquellos pixeles aun 

más extremos. 

 

Luego se mostrará la ventana #1 Density Slice donde se muestran los valores 

de rango de la cantidad de píxeles seleccionados para cada banda y se presiona el 

botón Apply, se despliega la ventana #1 PPI donde se muestran los píxeles extremos. 

En la ventana #1 MNF Band 1 se selecciona el menú Tools →Region Of Interest 

→Band threshold to ROI,  esto se hace para cambiar la extensión del archivo a 

ROI. Seguidamente se despliega la ventana Band Threshold to ROI Input Band,  

donde se selecciona el archivo PPI y se presiona OK, se despliega la ventana Band 

Thresh to ROI Parameters donde se colocan los valores máximos y mínimos del 

umbral aceptable en Min Thresh Value y Max Thresh Value obtenidos de la 

operación de distribución de rangos del PPI  y se hace clic en OK. Los valores 

mínimos y máximos del umbral deben ser tanteados hasta que en el cuadro emergente 

ENVI Question aparezca un número menor pero aproximado a 10.000. Luego de 

obtener el número deseado de puntos, se hace clic en YES y el software comienza a 

procesar la imagen. 

 

Consecutivamente se despliega la ventana #1 ROI Tool (FIG. A-23), en la cual 

se debe seleccionar el archivo generado y se pulsa la opción  File →Save ROIs, 

luego se escoge la ruta y el archivo de salida. En la misma ventana se selecciona la 

opción File  → Export ROIs to n-D Visualizer y se presiona OK. Después se abre 
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una ventana titulada Select Input Data File donde se escoge el archivo PPI y se hace 

clic en OK.  

 

Después se despliega la ventana n-D Visualizer input ROIs y se selecciona el 

umbral de puntos que se obtuvieron en el paso anterior, luego clic en OK, se 

despliega otra ventana titulada Output n-DState donde se debe presionar Choose para 

seleccionar el nombre y ubicación del archivo de salida, se presiona OK, y el 

programa regresa a la ventana n-D Controls (FIG. A-23), en la cual se debe 

seleccionar en el menú File→Save State…, después se debe hacer clic en el menú 

“Options → 3D: Drive Axes para permitir el movimiento de los ejes, se despliega 

una ventana titulada n-D Controls (FIG. A-23) y se escoge “1, 2 y 3” , haciendo clic 

sobre éstos números. Seguidamente se presiona Start. (ver Fig A-23) 

 

 
FIG. A- 23 Menú para exportar el ROI al visualizador y ventana n-D Controls. En el software  ENVI 

® 4.2 
 

Luego se muestran los píxeles extremos encontrados por la corrección PPI en 

un espacio tridimensional , donde se procede a seleccionar manualmente los píxeles 

más extremos observados en dicho espacio, se seleccionan pintando los pixeles 

extremos con un color diferente por grupo de pixeles. Al final de este proceso se 
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obtienen 7 clases de pixeles extremos, observados en la ventana #1 ROI Tool, en la 

misma ventana se seleccionan todas las clases, en la ventana Save ROIs to File se 

seleccionan también todas las clases. 

 

 Luego se debe presionar Choose para determinar el nombre y ubicación al 

archivo de salida, y para finalizar se presiona OK.  

 

A las imágenes se les aplicó el algoritmo “Spectral Angle Mapper” (SAM), 

este algoritmo calcula la distancia angular existente entre un espectro de referencia y 

un pixel cualquiera, esto filtra el número de pixeles existentes en la data cuando estos 

tengan un ángulo mayor al del espectro de referencia. 

 

Entonces, para realizar este algoritmo se selecciona Spectral en el menú 

principal de ENVI, luego se selecciona Mapping Methods → Spectral Angle 

Mapper ( Fig A-24), se abre una ventana titulada Clasification Input File, se 

selecciona el archivo obtenido del proceso anterior, se hace clic en el botón “Spectral 

Subset”.  

 

 
FIG. A- 24 Menú principal del ENVI para realizar la corrección SAM.  
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Seguidamente se despliega la ventana File Spectral Subset en la cual se 

escogen las tres primeras bandas   y se hace clic en OK. Inmediatamente se despliega 

la ventana Endmember colletion: SAM, se selecciona el menú Input → From 

ROI/EVF from input file…, se abre dentro de la misma ventana una tabla en la que 

se muestran las clases, se seleccionan todas y se presiona el botón OK, se despliega la 

ventana Spectral Angle Mapper Parameters en la cual se da ubicación y nombre al 

archivo de salida con la corrección SAM. 

 

A.3.5 CLASIFICACIÓN NO SUPERVISADA 

 
El siguiente paso es la clasificación no supervisada, con la cual el programa 

hace una clasificación de los píxeles por características similares,  que divide el 

espacio de las variables en una serie de regiones, de manera que se minimice la 

varianza interna de los pixeles incluidas en cada región.  

 

1. Para ello se selecciona en el  menú principal del Software ERDAS 

IMAGINE® 8.6, la opción Classifier → Unsupervised Classification, y en la 

opción  Input Raster se introduce el archivo generado en la corrección atmosférica 

FLAASH. En la opción Output Cluster Layer se escoge la ruta y el nombre del 

archivo imagen de salida y en la opción Output Signature Set el nombre y ruta de 

salida del archivo que contiene las clases obtenidas y se pulsa Ok (FIG. A-25). Luego 

comienza el análisis estadístico representando su avance en una barra de progreso 

(FIG. A-25). 
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FIG. A- 25 Clasificación no supervisada en el menú principal de ERDAS. En el software  ERDAS 

 
2. Una vez finalizado el proceso, en la ventana Viewer # 1 se abre el archivo 

generado, sobre esta ventana se pulsa el botón derecho del Mause y del menú 

desplegable que aparece se selecciona la opción Fit Image to Window. En la misma 

ventana se pulsa Raster → Attributes. Aparece un aventana que contiene todas las 

clases obtenidas donde se procede a realizar la interpretación (FIG. A-26). 

 
FIG. A- 26 Resultado de la clasificación no supervisada y vista de las clases obtenidas. Imagen 

P003R056. En el software  ERDAS. 
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A.3.6 CLASIFICACIÓN SUPERVISADA 

 
 En seguida se debe realizar la clasificación supervisada, que consiste en hacer 

una clasificación de los píxeles con características similares, que el usuario define 

mediante la observación de la imagen, con previo conocimiento geológico del área. 

 

 Para hacer esta clasificación en primer lugar se debe abrir la imagen resultado 

de la corrección FLAASH, en el software ERDAS IMAGINE, en el menú principal 

de la ventana Viwer #1 se selecciona Raster → Tools…y se despliega la ventana 

Raster en la cual están las herramientas para modificar las imágenes, se selecciona la 

herramienta Create Polygon AOI, luego en el menú principal  se selecciona 

Classifier, se despliega la ventana Classification y se hace clic sobre el botón 

Signature Editor  y se despliega la ventana Signature Editor, posteriormente con la 

herramienta se hace un polígono sobre la imagen en aquellas regiones cuyas 

características son similares tales como: Suelos residuales, valles, sembradíos,  

drenajes, nubes, sombras de nubes, cuerpos de agua, vegetación, roca, suelo; al 

seleccionar una clase encerrándola en un polígono se procede a presionar el botón  

“+└►” , de inmediato se adhiere la clase seleccionada , se encierran en polígonos 

varias clases de las mismas características. Este procedimiento se repite tantas veces 

como clases se deseen crear. 

 

 Seguidamente en la ventana Signature Editor se hace clic sobre File → Save 

y se guardan las clases, en la ventana Viewer #1 se hace clic en File → Save → All 

Layers y se guarda el archivo de la imagen,  luego en la ventana classification se 

hace clic en Supervised Clasification, se despliega la ventana Supervised 

Clasification y se introducen los nombres del archivo de imagen recién creado, el 

nombre del archivo signature y se da un nombre de salida para el archivo que va a 

tener la clasificación supervisada. Para finalizar se hace clic en OK y  se obtiene la 

clasificación supervisada (FIG. A-27). 
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FIG. A- 27 Resultado de la Clasificación Supervisada y vista de las clases obtenidas. Imagen 

P003R056. En el software  ERDAS 
 

A.4.  REALIZACIÓN DEL ÍNDICE DE VEGETACIÓN 

 
El mismo, consiste en identificar la cantidad de material vegetal existente en 

la superficie. Para efectuar esto en el software ERDAS  IMAGINE® 8.5 en el menú 

principal se hace clic en Interpreter, se despliega la ventana image interpreter, luego 

se hace clic sobre el botón Spectral Enhancement lo cual despliega la ventana 

índice. En ésta ventana se determina el archivo al cual se le va a aplicar el 

procedimiento, y se le da una ubicación y nombre de salida. Luego en select functions 

se selecciona Veg Index, en sensor se selecciona Landsat TM. Y para finalizar se 

presiona OK (FIG. A-28). 
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FIG. A- 28 Procedimiento en ERDAS para realizar el índice de vegetación. En los colores claros, se 

encuentra la mayor concentración de vegetación. Imagen P003R056.  
 

 

A.5 FIRMAS ESPECTRALES 

 
A continuación se deben realizar las firmas espectrales en ERDAS, que 

consisten en caracterizar diferentes lugares de la zona de estudio con la finalidad de 

obtener su firma espectral que es característico de cada material que compone la 

superficie.  

 

Por lo cual, se debe abrir el archivo resultante de la clasificación supervisada. 

Luego en la ventana Viewer #1 se selecciona el menú Raster → Tools…, Se 

despliega la ventana Raster (FIG. A-29),  se selecciona la herramienta Create 

polygon AOI. Después en el menú principal del ERDAS se hace clic sobre el botón 

Classifier , se despliega la ventana classification, se hace clic en Signature Editor. 
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Entonces con la herramienta Create poligon se hacen polígonos sobre las regiones de 

interés, luego en la ventana Signature Editor se presiona el botón  “+└►”, para 

agregar la clase.  

 

Posteriormente se hace clic sobre el botón “ ” y se muestra la ventana 

signature mean plot (FIG. A-29) donde se muestra el histograma de la clase. Una vez 

obtenida la firma espectral de la clase, se procede a determinar el material 

correspondiente a esa firma espectral (FIG. A-29). 

 

 
FIG. A- 29 Firma espectral del Agua en ERDAS Imagine. 

 

A.6 MODELO DIGITAL DE ELEVACIÓN (DEM) 

 
Es una representación digital de la superficie terrestre, permite observar el 

área de interés en 3D, facilitándole al usuario una mejor observación de la topografía 

del terreno, estructuras de deformación, buzamientos, etc. Para realizar el DEM se 

procede de la siguiente manera: 
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1. En el menú principal de ENVI, se abre la imagen corregida en Flaash, luego 

se selecciona la opción  Topographic → 3D SurfaceView (FIG. A-30). 

 

 
FIG. A- 30 Despliegue de la Imagen P004R056, combinación R5G4B3 en el menú principal de ENVI 

y selección de 3D SurfaceView. 
 

2. Se despliega la ventana 3D SurfaceView Input Parameters, donde se 

selecciona la calidad de la imagen  en DEM Resolution y se exagera la escala vertical 

para una mejor observación, luego se presiona Ok.  Aparece la ventana Slect Spatial 

Subset  donde se presiona Reset, y en la ventna Subset by Imagen se escoge el área de 

interés para realizar el DEM y se hace clic en Ok  (FIG. A-31). 
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FIG. A- 31 Ventanas  3D SurfaceView Input Parameters, Select spatial Subset  y Subset by Imagen 

para la selección del área donde se quiere realizar el DEM, en el Software ENVI. 
 

3. Se abre la ventana 3D SurfaceView que muestra el DEM generado (FIG. A-

32), en esta misma ventana se hace clic en Options → Surface Controls… y se 

despliega la ventana 3D SurfaceView Controls, donde se le puede cambiar las 

popiedades del DEM (FIG. A-33).  
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FIG. A- 32 Modelo Digital  de Elevación (DEM) de la imagen P004R056, combinación R5G4B3, una 

escala de exageración  vertical de  0.6 y selección de Textura en la opción Surface Style en el menú 
principal de ENVI. 
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FIG. A- 33 Modelo Digital  de Elevación (DEM) de la imagen P004R056, combinación R5G4B3, una 
escala de exageración  vertical de  0.6 y selección de Mayado en  la opción Surface Style en el menú 

principal de ENVI. 
 


